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Clements-AP Chemistry

Creating Graphs Using Microsoft Excel and Word
Created by Carlos Gonzalez, 2006

Starting Out
Microsoft Office has a built in feature to create graphs from a data table. The following information
will help you create different types of graphs, make easy analysis of graphs, and make them easy to

read and display information.

No matter what program in Microsoft Office you are using (Word, Excel, or PowerPoint); the graph
function will be available.

- To create a new graph in Word: select Insert 2 Picture = Chart.
- To create a new graph in Excel or PowerPoint: select Insert 2 Chart.
Choosing the Type of Graph

After selecting chart in PowerPoint or Word, a graph and datasheet will be displayed.
* Using this part with Excel will be explained later.

When the chart area is displayed, right-click on the inside area (but not on the chart) and select
Chart Type.

The window will have two tabs, “Standard Types” and “Custom Types”. Make sure “Standard
Types” is the tab you selected. In the list below, select the graph that best fits your needs. Then
choose how you want it to look in the Chart Sub-Type and then click OK.

You will now notice that the sample graph has been changed to the type of graph you selected.

The datasheet should still be open at this point, right click on the very top left tab:

27.4 90|

38.6 34.6
46.9 45

Select this Tab

You will notice it will select everything. Press the Delete Key to erase the entire table. This will
make the chart in the chart area disappear. DO NOT PANIC! There is no data available to make a
chart; this will be explained next. This page will help you with the two simplest types of graphs: bar
and line graphs.
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Bar Graphs

If you selected to make a bar graph, your data must be in the following format on the datasheet.

‘# Presentation1 - Datasheet

[N -

v
< ?

Different Sets of Data* X-Values Row

Ok, “Different Sets of Data” indicate how many bars you want. For example, if you have multiple
trials of data, you can put “Trial 1” in Row 1 and “Trial 2” in Row 2. This would create multiple bars
in your graph.

Your X-Values are going to start on Column A and keep going along that row.

The rest of the data will go on the row where a “Set of Data” is defined. These will be your Y values.
Here is a sample data table and below will show you the proper orientation in the datasheet.

Data from Titration Lab

Flask Volume NaOH (mL) Volume HC;H30; (mL)
1 16.00 11.20
2 24.95 10.50
3 17.10 10.00
Datasheet:

‘# Presentation1 - Datasheet

A B C D~
Volume NaOH (mL)|Volume HC2H302 (mL)
1 ol|Flask 1 16.00 mL 11.20 mL
2 mB|Flask 2 [24.95 mL 10.50 mL
3 mB|Flask3 [17.10 mL 10.00 mL
2 3
< ?

(This will give a graph on the following page.)
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Graph:

oFlask 1
o wFlask 2| o
mFlask 3
Volume NaOH Volume HC2H302
o o o]

The graph will then look like that above. However, it is missing some labels that will be discussed
later. Now for a line graph...

Line Graphs

Line graphs are very similar to bar graphs by the data sheet; however, the data will be displayed
differently. Line graphs also have additional features that bar graphs do not. Also the type of line
graph you select will affect your graph’s look. On the chart type selection choose Line if you want
the data already connected in a linear progression. If you have data that is just a bunch of points
and you want to find the best-fit line, select the XY (Scatter) option and select just the point values.

The data sheet will work the same was as the bar graph.

Here is some sample data, the datasheet, and graph:

Temperature (°K) Vapor Pressure H,O (mmHg)
353.0 326.952
348.0 273.904
343.0 217.284
338.0 190.912
3324 151.316
327.9 131.480
323.0 107.312
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Datasheet:

i# Presentation1 - Datasheet

A B C D E F G H A
Temperature (°K)| 353 348 343 338| 3324 321.9 323 E
21|Vapor Pressure H| 326.95| 273.9] 217.284] 190.912] 151.316]  131.48] 107.312

Graph:
(XY Scatter)

350

300

250

200

+ Vapor Pressure H20
(mmHg)

*

150

100 +—=

50

320 330 340 350 360

(Line)
350

300 \

250

200 =
* —e—Vapor Pressure H20
\ (mmHg)

150

100

50

0 T T T T T T
353 348 343 338 3324 3219 323
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If you look at the two graphs, the XY Scatter is just like a coordinate plane where the Line graph is
not. The Line graph is merely a line that shows a trend in a series of data. The XY Scatter is what
you will need to use for most graphs in this course.

Best Fit Lines in XY Scatter

A best-fit line would be great to show an average of the data in a linear method, or it can be used to
attain an equation of a line.

A best-fit line can be achieved by the following step. (You must have the chart area open for editing.)
Select Chart > Add Trendline...

A window will then appear that gives the type of trend line you can insert. Depending on the data
you have, you may want to select a different type. Since I want the linear best-fit line, I will select a
linear best-fit line. Note that you might need to use a different type of line for different sets of data.
Trying out multiple fits never hurts. On the Options Tab, you can put a name on the line (best if you
have multiple best-fit lines), and adjust some of its properties. The line can be extended in both
directions (helpful if you predict something). The one option that will help you the most is to select
the “Display Equation on Chart” option. Select it and press OK.

The chart will then look like this:

350
300 //
250
200 / + Vapor Pressure H20
> =
gy = 7.1787x - 2225.8§ (mmHg)
/ T Linear (Vapor

150

/ Pressure H20 (mmHg))
100 +—2%
50

0 T T T

320 330 340 350 360

You can use the y = mx + b equation to then substitute values, determine the slope, and predict
values.
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Chart Labels and Formatting

0k, so you now have all your data plugged into a graph (bar or line); however nothing is labeled and
your data might not be displayed the best way. Right-click outside the chart in the chart area and
click on Chart Options.

This window has many tabs that are mostly self-explanatory, yet I will go through a few of them.

¢ The titles tab can be filled in with the proper labels and it will give you a preview of how
your graph will look.

¢ The axes tab needs to have the values on them... do not change this.

¢ The gridlines tab is for the lines going across your graph. If you like the look of graph paper
select both x and y. If you like no lines, then de-select everything.

* The legend tab basically asks where you want the legend to be displayed if you choose to
display it (recommended for multiple lines/bars).

¢ The data labels tab can be handy if you want the y-values displayed on the graph.

Once all that is set up, click OK. The graph should now be set up and labeled properly.

If you wish to change the way the graph looks (font and size) right-click on chart area and click on
“Format Chart Area.” This will format the entire chart, all titles, and any labels on the graph. Each
one can be selected and changed individually if you wish to change them again.

Editing the X and Y Axes

You may wish to have different values on your axes than they are given. Right-click on the axis you
wish to edit and you will see that the only tab you want to edit would be the scale tab.

The chart is automatically sized to best fit your data; however, you may want to change it to best fit
your trend line. Inserting a value will automatically change it, and it will not automatically adjust

until you click the check mark next to it.

Click OK when you have made the proper changes.

Finished!

This completes how to create a graph. There are a few things I have left out about changing things.
However, you can right-click on almost every object and change almost anything about it. Feel free
to play with the graph until you get it to how you like it!
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*Hints and Formulas with Excel

Excel also has some help in calculating mass amounts of data. This will save you a lot of time in
some labs where there may be 6 trials that involve multiple calculations. The formula bar (found
directly above the spreadsheet area) can help you do simple to complex calculations very quickly
and easily.

The formula bar works like a calculator. Knowing how to use this feature will greatly help you in
calculations. Here are a few sample formulas with simple calculations:

A2 v & <4——— Formula Bar
A B C D

.

Ok, in this screen you can see that cell C1 has the formula “=A1+B1”. You can easily see that it adds
the two cells, Al and B1, together.

Now, for larger sets of data, you can drag your formula across multiple cells. Let’s say that you have
10 cells of numbers and you want to take the natural log of them all. Instead of working them all
out on the calculator, have Excel just give you the answers. Here’s how it works.

B1 v A =LNAT) 4— Natural Log formula, this will be
A B C D discussed later.

122] 4.304021

124
242

(&8
o

Use this square to drag your
formula.

W 0

oy
[C=)
1 4= 00 Q0 = =

W00~ O N & Wk -
[#8]

—

o

) -

4= o o
rans

(&3]

Then you get...

B1 v e =LN(AT) *You can always copy and paste your data to Word.
A B C D The boarders will not show up though, so be sure to
122] 4. 5304021 change that!
124] 4 820282
242| 5488938
345] 5.843544
5869297
6.375025
6.548219
6.80017
7.118016

8147578

W 0

oy
[C=)
1 4= 00 00 = =

WO~ O B Wk =
(8]

—
o
) -

= no o
o
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There are a lot of different formulas that you can use. If you go to Insert 2 Formula there is a rather
comprehensive list of formulas you can choose. It will also help you with the syntax of the formula.
You can never use too many parenthesis, [ can’t stress this enough.

5T | NCLIONN
Search for a function:
vape a brief description of what you want to do and then ‘
| click Go |
Or select a category: :AII 4— g Make sure this says “All” for a

complete list.
Select a function:

. -~ |
ACQOS (=
ACOSH

ADDRESS

AND

AREAS . |
ASIN lill

ABS(number)
Returns the absolute value of a number, a number without its sign.

Help on this function I OK I [ Cancel

Once you have all the data you need, organize what you want to graph and start creating your graph
by selecting data.

Keep in mind that Excel is the easiest program to graph with, however, Word works perfectly fine
as well.

Wrap Up

Hopefully this guide has helped you to make professional looking graphs and enhance the quality of
your lab reports. It never hurts to experiment with your data and see what you can come up with!

10
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SEPARATION & PURIFICATION

Duration: 1 day

INTRODUCTION

The four major steps involved in the analysis of a substance are 1) collection of the sample, 2)
preparation for measurement, 3) measurement, and 4) evaluation of data. This experiment is
designed to illustrate four techniques commonly used to purify and otherwise prepare a sample for
measurement. These are decantation, filtration, coagulation, and distillation. A brief discussion of
these techniques is presented below. The remaining steps are subjects of future experiments and
discussions.

Decantation

Many liquids can be easily separated from unmixed solids by decantation or carefully pouring
the liquid off. An example would be a mixture of sand and water. The decantation process is
illustrated in Figure 1.1.

Filtration

A solution quite often contains solid matter whose density is almost the same as the density of
the liquid portion. When this is the case, the solids do not settle to the bottom, and separation
by decantation is impossible. Under this circumstance, filtration is useful. Filters are composed
of insoluble solids whose pore size allows the liquid portion of a sample to pass through but not
the solid portion. Quite often it is the solid portion that is desired for analysis. In either event, a
separation is effected. Folding of the filter paper is illustrated in Figure 1.2 and a typical
apparatus for gravity filtration is shown in Figure 1.3.

Coagulation
A solution may contain suspended particles of colloidal size that pass through filter paper.

However, they can be forced to settle by the formation of a gelatinous precipitate in the
solution, which as it falls to the bottom of the container, carries down most of the insoluble
matter. This process is known as coagulation and is used in many municipal water treatment
plants as one of several purification steps.

Distillation

Distillation is a common purification technique that is used in the separation of volatile liquids
from undesirable impurities that are usually non-volatile. A typical experimental distillation
apparatus is shown in Figure 1.4. The volatile liquid to be purified is vaporized in the round-
bottom flask, converted back to a liquid in the condenser, and finally collected in the receiving
flask. The non-volatile impurity remains in the original mixture. To avoid bumping (when air
trapped in a bubble rapidly escapes and just makes a frightful mess!), especially when solid
material is present in the bottom of the distillation flask, 2-3 small boiling chips, or CaCO3
pellets, are added to the flask before heating.

11
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OBJECTIVES
In this experiment, you will

* Separate a mixture using four techniques.
* Test for the purity of the sample.

MATERIALS
Mixture of sand, dirt, salt, and water Burner
Beakers Round bottom flask
Filter paper Ring
Funnel Wire gauze
Graduated cylinder, 100-mL Clamps
Saturated Ca(OH): Thermometer
0.1 M Al2(SO4)3 Stopper
Test tube Condenser
AgNOs3, Erlenmeyer flask
Ring stands
PROCEDURE
1. A mixture of sand, dirt, salt, and water awaits you. Record observations from each of the

following steps in your lab notebook. In a 250-mL beaker obtain approximately 100 mL of this
mixture. Allow it to sit undisturbed for several minutes. Carefully pour the liquid portion into
another beaker without disturbing the insoluble sediment. Discard the sediment into a lined
trashcan. Keep the decanted solution for use in the next portion of the experiment.

Flute a sheet of filter paper and place it in a funnel. Pour the solution obtained in step 1 through
the filter paper, being careful not to allow it to overflow. Collect the solution in a 100-mL
graduated cylinder.

From the reagents provided, mix 8 mL of saturated Ca(OH); with 2 mL of 0.1 M Alz(SO4)3 in a
test tube and shake. Add this solution to the solution from step 2 and allow settling. The
reaction occurring is:

A12(504)3 + Ca(OH)z > ?

Decant approximately 50 mL of clear solution from step 3 and add several drops of AgNOs3,
sufficient to form a white precipitate indicating a positive test for dissolved chloride ions. The
net ionic reaction occurring is:

Ag+(aq)+ Cl-(aq) > AgCl(s)
The chloride ions are present because the original solution contained some NaCl

Place the solution from step 4 in the distillation flask and assemble your distillation apparatus
(See illustration on following page). Distill the solution until approximately 10 mL of distillate
have been collected. Remove the burner and test the distillate for the presence of dissolved CI-.
Determine if your distillate was indeed purified.

17
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LABORATORY REPORT (25)
Include your objective and paraphrased procedure. Your observations of each step should be
included in full. There are no calculations or graphs associated with this experiment. Remember to

write your conclusions.

thermometer
clamp

distillation flask

condenser

cooling water

X
cold water

receiving flask

distilled
water

clamp stand

Distillation apparatus

12



Clements-AP Chemistry

LAW OF DEFINITE PROPORTIONS

Duration: 1 day

INTRODUCTION

Dalton’s celebrated atomic theory included the concepts that all atoms of a given substance have
the same weight and that combinations of atoms form compounds. The experimental information
referred to as the Law of Definite Proportions supports these two concepts. Without exception,
careful study of binary compounds bonded by conventional covalent or ionic bonding has shown
that each compound always contains the same weight percentages of the two elements entering
into chemical combinations to form the compound. The purpose of this experiment is to repeatedly
synthesize a binary compound and to determine its empirical formula.

You will chemically combine copper and iodine. Copper is a soft metal that will be used in the form
of a fine wire. Iodine is a solid that sublimes readily; that is, with gentle heating, the solid is
converted to a vapor. In this experiment, the iodine vapor will be brought into contact with the
copper wire. A new compound is formed in a chemical reaction, and it appears in the form of a
white solid that adheres to the surface of the copper wire. The copper wire will then weigh more
than it did originally because of the adherent compound. Note that the additional weight is due
only to the iodide ions in the compound since the copper ions in the compound were originally part
of the weight of the copper wire. The copper atoms have simply changed from an association with
other copper atoms in the metal to an ionic association with iodide ions in the compound.

The chemical properties of ions of copper as they are found in the compound are different from the
chemical properties of those copper atoms found in the metal. In particular, the ions of copper as
they are found in the compound will react with a solution of sodium thiosulfate, Na;S,03, to form a
new water-soluble substance containing the copper ions (copper wire will not react with the
Na;S,03 solution). As a result, the copper compound dissolves while the unreacted copper atoms
do not. Now, the copper wire, stripped of its coating of the compound, will weigh less than the
original copper wire because some copper atoms have been removed from the surface. In fact, the
difference in weight is just the weight of copper atoms that entered into chemical combination with
iodide ions to form the white solid compound. Thus, the weight the copper wire gains upon being
coated with the compound is due to the iodide ions in the compound; and the weight the copper
wire has lost when the compound is stripped is due to the copper ions in the compound.

According to the Law of Definite Proportions, the weights of copper and iodine that combine to
form the compound must always have the identical ratio.

OBJECTIVES
In this experiment, you will

* Determine the moles of copper and iodide ions present in a compound formed.
* Determine the formula of that copper iodide compound.

14
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MATERIALS
#22 Cu wire Wash bottle w/dH,0
[> vapors 0.5 M NazS203
2 M HNOs3 Balance
Acetone
PROCEDURE
1. Wind a piece of #22 Cu wire tightly around a pen or pencil so as to form a spiral of wire. Leave

about 5 cm of straight wire to be used as a handle. Form a short bend in the end of the handle
so that the coil can be suspended from the rim of a test tube. Make certain that the wire is
approximately 3 cm from the bottom of your test tubes and that the coils are not so compressed
that they touch each other.

Dip the Cu wire in a dilute solution of HNO3 (2 M) for about 15 seconds. Then rinse the coil with
distilled water from the wash bottle. Repeat this process once. Dip the coil in acetone and let
the coil air-dry.

Weigh the Cu coil on the top-loading balance by placing it gently on a piece of weighing paper
that is already on the zeroed balance. Record all masses to the nearest 0.001 g in your data
table.

You will find test tubes containing iodine being warmed in water baths so that iodine vapors
rise near the top of the test tubes. Insert the coil in the test tube labeled with your lab station
number and hook the handle of the coil over the rim of the test tube. Leave the coil in contact
with the iodine vapors for 5-10 minutes. You should be able to see the copper iodide compound
forming on the coil.

Carefully remove the wire from the test tube, taking care not to shake or jar it so severely that
some of the coating is lost. Allow the wire to cool for 1 minute. Weigh the coated wire on the
top-loading balance and record.

Immerse the coated coil in 0.5 M solution of Na;S;03 for 2-3 minutes. After the bright surface of
the Cu reappears, remove the coil from the solution and rinse it in distilled water using the
wash bottle.

Dip the coil in acetone, air-dry, weigh the coil on the analytical balance, and record.

Repeat the procedure at least two times.

15
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DATA TABLE

Trial 1 Trial 2 Trial 3

Mass of Cu wire before reacting (g)

Mass Cu wire w/iodide ions after reacting (g)

Mass of Cu wire after cpd is removed (g)

LABORATORY REPORT (35)

Include your objective and paraphrased procedure in paragraph format. Your observations of each
step and all of your data should be clear. You need only show one calculation of each type in your
lab report. Show all work performed in determining your average mole ratio of copper to iodine in
the compound. Reduce this ratio to its simplest form, and you will have the empirical formula of
your compound. In your conclusion address your findings and explain the following: If you had not
removed the entire compound from the wire before beginning a new trial, how would your
subsequent calculations have been affected?

1A
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THE DETERMINATION OF THE PERCENT WATER IN A COMPOUND

Duration: 1 day

INTRODUCTION

The polarity of the water molecule, which makes it a great solvent for ionic compounds, causes
water molecules to cling to the structure of solid substances. When this occurs, the trapped water
molecules are called water of hydration and they become an integral part of the crystal structure.

There are many compounds that have a tendency to absorb water vapor from the air. These
compounds are said to be hygroscopic, and can be used as moisture-reducing agents. Other
compounds absorb such large quantities of water vapor that they will actually dissolve in their own
water of hydration, a property known as deliquescence.

In this experiment, you will test a hygroscopic ionic compound to determine its water of hydration.
Although the water molecules are securely attached to the ionic solid that you will test, they are
susceptible to removal by heat. You will gently heat a sample of the compound to drive off the water
of hydration. By measuring the mass of the sample before and after heating, you can determine the
amount of water in the sample and calculate its water of hydration.

OBJECTIVES
In this experiment, you will

* Carefully heat a measured sample of a hygroscopic ionic compound.
* Determine the water of hydration of the compound.
* Complete the chemical formula of the compound.

MATERIALS
Crucible with cover One of the following compounds:
Crucible tongs Magnesium sulfate, MgSO4enH,0
Spatula Copper (II) sulfate, CuSO4enH-0
Ring stand, ring, and clay triangle Manganese (II) sulfate, MnSO4enH,0
Burner Sodium carbonate, Na;COzenH>0
Desiccator Balance

PROCEDURE

1. Measure and record the mass of a clean, dry crucible with cover. Obtain about 1-1.5 g of the
selected compound and place it in the crucible. Use a spatula to break up any large pieces of the
substance by pressing the pieces against the wall of the crucible. Measure and record the mass
of the crucible, cover, and compound.

2. Setup aring stand, ring, and clay triangle for heating the sample. Rest the crucible on the clay
triangle. Tip the cover slightly so that it does not fit snugly on top of the crucible. Set up a lab
burner and ignite the burner away from the crucible. Adjust the burner to get a small flame.

3. Gently heat the crucible for about ten minutes. Depending on the compound that you selected,
the color of the sample may change significantly as the water of hydration is driven out of the
crystals.

4. Turn off the burner. Cover the crucible and allow the sample to cool for about ten minutes.

17
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5. When the crucible is cool enough to handle safely, measure and record the mass of the crucible,
cover, and contents.

6. Heat the crucible of your sample for five more minutes, allow it to cool, and measure and record
its mass.

7. Continue heating the sample for five minutes at a time, until you have two mass measurements
that are within about 0.050 g of each other. If time constraints force you to complete the
experiment on a second day, place the crucible in a desiccator until you can continue your work.

8. Dispose of your sample as directed.

DATA TABLE

Compound selected for analysis

Mass of crucible and cover (g)

Mass of crucible, cover, and hydrated sample (g)

Mass of crucible, cover, and dehydrated sample - 1st weighing (g)

Mass of crucible, cover, and dehydrated sample - 2nd weighing (g)

Mass of crucible, cover, and dehydrated sample - 3rd weighing (g)

Mass of crucible, cover, and dehydrated sample - 4th weighing (g)

LABORATORY REPORT (25)

Include your objective and paraphrased procedure in paragraph format. All of your data collected
should be included in your report. Show one calculation of each type (include such simple
calculations as subtraction!). Your calculations should reveal the following: mass of hydrate, mass
of dehydrated sample, mass of water evolved, moles of water in hydrate. Give the results of all
calculations. Show your work in determining the formula of the hydrate. In your conclusion
address your findings and explain the following: If you had not heated the sample long enough to
remove all of the water of hydration, how would your subsequent calculations have been affected?

1R
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DETERMINING THE MOLE RATIOS IN A CHEMICAL REACTION

Duration: 1 day

INTRODUCTION

A balanced chemical reaction equation gives the mole ratios of the reactants and the products as
coefficients. When some of the chemical formulas are not known, an experiment must be conducted
to help determine the mole ratios.

This experiment uses two common substances as the reactants: hypochlorite ion (OCl-) from
household bleach and thiosulfate ion (S2032-), the active ingredient in a photographic “fixer”
solution used to develop film. In the reaction, hypochlorite ions oxidize the thiosulfate ions
according to the unbalanced and incomplete reaction equation below.

A OCI- + B S;032- — products

It is possible to identify the coefficients, A and B, for the reactants, without knowing the products of
the reaction. The process that you will use to determine the coefficients is called continuous
variations. You will prepare a series of mixtures of the two reactants. Each mixture will have the
same total volume . The reaction is exothermic. In procedure A, the mixture that generates the
most heat energy will be the reaction that completely consumes both the hypochlorite and the
thiosulfate ions. In procedure B, the point at which the temperature no longer changes will be the
reaction that completely consumes both the hypochlorite and the thiosulfate ions. By choosing one
of the procedures, you will use this mixture to establish the coefficients, and therefore the mole
ratio, for the reaction.

OBJECTIVES
In this experiment, you will

* Measure the enthalpy change of a series of reactions.

* Determine the stoichiometry of an oxidation-reduction reaction in which the reactants are
known but the products are unknown.

N~

Reaction vessel and temperature probe

10
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MATERIALS

Vernier LabQuest 0.50 M sodium hypochlorite, NaOCl, solution

Temperature Probe 0.50 M sodium thiosulfate, Na,S;03, solution in

0.2 M sodium hvdroxide, NaOH

Stands/buret clamps, burets Styrofoam® cups

Beakers

PROCEDURE A

1. Connect a Temperature Probe to Channel 1 of the Vernier computer interface.

2. Measure precisely 25.0 mL of the 0.50 M NaOCl solution. Pour this solution into a Styrofoam
cup and nest the cup in a beaker to help stabilize the cup (see illustration on previous page).

3. Immerse the tip of the Temperature Probe in the Styrofoam cup of NaOCl solution.

4. Measure precisely 25.0 mL of the 0.50 M Na;S203 solution. Note: Do not mix the two solutions
yet.

5. Click to begin data collection. Let the program gather and graph a few initial
temperature readings, and then add the Na;S,03 solution. Gently stir the reaction mixture with
the Temperature Probe.

6. Collect data for 3 minutes. Only if the temperature readings are no longer changing may you
click [ ® stop | op [» Collect| ¢4 end data collection before 3 minutes have passed,.

7. Examine the graph to calculate and record the minimum and maximum temperatures for this
volume ratio of the 0.50 M NaOClI solution and the 0.50 M NaS;03 solution.

* To determine these temperatures, click Analyze—> Statistics> Temperature. The minimum
and maximum temperatures are listed in the statistics box on the graph.

8. Rinse and dispose of the reaction mixture down the sink.

9. Open a new file by clicking File>New. Select Discard when prompted unless you wish to save
the previous run on a flash drive.

10. Repeat the necessary steps to continue testing various ratios of the two solutions, keeping the
total volume constant at 50.0 mL, until you have three measurements on either side of the ratio
that produced the greatest temperature change. Record your volumes of each solution and
your minimum and maximum temperature for each ratio.

PROCEDURE B

1. Connect a Temperature Probe to Channel 1 of the Vernier computer interface.

2. Measure precisely 5.0 mL of the 0.50 M Na;S,03 solution. Pour this solution into a Styrofoam
cup and nest the cup in a beaker to help stabilize the cup (see illustration on previous page).

3. Immerse the tip of the Temperature Probe in the Styrofoam cup of Na,S;03 solution.

4. Measure precisely 44.0 mL of distilled water and add to the cup.

5. Measure precisely 1.0 mL of the 0.50 M NaOClI solution. Note: Do not mix the two solutions yet.

70
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10.

11.

Click to begin data collection. Let the program gather and graph a few initial
temperature readings, and then add the NaOCI solution. Gently stir the reaction mixture with
the Temperature Probe.

Collect data for 3 minutes. Only if the temperature readings are no longer changing may you
click [ ® stop | op [» Collect| ¢4 end data collection before 3 minutes have passed,.

Examine the graph to calculate and record the minimum and maximum temperatures for this
volume ratio of the 0.50 M NaOClI solution and the 0.50 M NaS,03 solution.

* To determine these temperatures, click Analyze—> Statistics> Temperature. The minimum
and maximum temperatures are listed in the statistics box on the graph.

Rinse and dispose of the reaction mixture down the sink.

Open a new file by clicking File>New. Select Discard when prompted unless you wish to save
the previous run on a flash drive.

Repeat the necessary steps to continue testing various ratios of the two solutions, keeping
Na;S203 solution volume constant at 5.0 mL and the total volume constant at 50.0 mL,. Adjust
the distilled water and NaOCI solution volumes until you have three constant temperatures.
Record your volumes of each solution and your minimum and maximum temperature for each
ratio.

DATA TABLE

Volume OCI- Volume S;032- Minimum/Maximum
(mL) (mL) Temperature (°C)
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LABORATORY REPORT (40)

Include your objective and paraphrased procedure in paragraph format. All of your data collected
should be included in your report. Show one calculation of each type (include such simple
calculations as subtraction!). Your calculations should reveal the following: temperature changes
and mole ratios of reactants. Give the results of all calculations. Make a graph plotting volume of
OCI- (mL) versus temperature change (°C). In your conclusion address your findings and the
following:

* The molarities of the reactant solutions were equal in this experiment. Is this necessary, or
even important, for the success of the experiment?

®*  Which solution was the limiting reactant in each trial?

* Ifthe actual reaction between OCl- and S;032- in this basic medium produces sulfate ion,
chloride ion, and water, what is the actual mole ratio of the OCl- and S;032-? (Hint...balance
using the half-reaction method!)

®* Does the mole ratio that you determined in your experiment match the actual reaction
equation’s coefficients for the two reactants? Explain, especially if your mole ratios do not
match the coefficients.
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OXIDATION-REDUCTION TITRATION WITH POTASSIUM DICHROMATE

Duration: 2 days

INTRODUCTION

The experiment illustrates how an oxidation-reduction reaction may be used to perform a
volumetric analysis of iron. A solution of K,Cr;07 serves as the oxidizing agent to bring about the
oxidation of an unknown amount of Fe2+ to Fe3+. An organic dye, which changes color at the redox
potential of the equivalence point (when all of the ferrous ions have been oxidized), is used as an
indicator.

The potassium dichromate has advantages over other oxidizing agents such as potassium
permanganate in that its solutions are quite stable, even at higher temperatures, and that it is
capable of oxidizing other species, such as the chloride ion, which are often present. The netionic
reaction is as follows:

Cr2072- + 6 Fe2* + 14 H1*> 2 Cr3++ 6 Fe3+ + 7 H,0 How many e are exchanged?

The redox indicator is a soluble organic compound that exists in two states of oxidation. These two
forms are different colors. The barium salt of diphenylamine sulfonate serves as such an indicator,
and the color change is from colorless to deep purple. This color change can be seen even in the
presence of the green Cr3+ ions that are formed by the reduction of the dichromate.

The sulfuric/phosphoric acid mixture is needed because it forms complex ions with the ferric ions,
thereby lowering the Fe2+/Fe3+ potential. This gives greater differentiation between the Fe2+/Fe3+
potential and that of the two forms of the indicator. Thus, there is less chance of the indicator itself
being oxidized before the oxidation of the Fe2+ is complete.

OBJECTIVES
In this experiment, you will

* Perform an oxidation-reduction titration.
* Determine volume of Cr;07% required to reach the endpoint.

* Perform stoichiometry to determine the mass of Fe2+ present in the sample and the
percentage of Fe2* in the sample.

MATERIALS
Unknown containing Fe2+ Concentrated sulfuric/phosphoric acid mixture
K2Cr207 Stand/buret clamp, buret
250-mL volumetric flask Parafilm
Redox indicator Balance

Erlenmeyer flasks

PROCEDURE

Part I Making KCr.07, weighing samples, and initial titration

1. Weigh approximately 1.2 g of K2Cr,07 on the top-loading balance and record its exact mass to
0.001 g in your data table. Transfer the weighed amount of K>Cr;07 to a clean 250-mL
volumetric flask and dissolve it in tap water, diluting the solution exactly.
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6.

Weigh three samples of approximately 1.0-1.4 g (recorded to the nearest 0.001 g in your data
table) of your unknown. Place each into its own 250-mL Erlenmeyer flask.

To your lowest weight sample, add 75 mL of tap water, 8 drops of redox indicator, and 15 mL of
the concentrated sulfuric/phosphoric acid mixture. Be extremely careful with this mixture.

Transfer several mL of the K;Cr207 to a clean buret and rinse it with several small portions of
the solution. This ensures that the standard solution will not be diluted when the buret is filled.
Fill the buret and zero it using a waste beaker.

Using a white piece of paper or a paper towel as a background, titrate the lowest weight flask to
a deep purple endpoint. The solution will pass through a green color on the way to the
endpoint. Be certain to obtain a definite purple color. Record the volume (to the nearest 0.01
mL) of K;Cr;07 needed to reach the endpoint in your data table.

Cover your remaining two samples with Parafilm until Day 2.

Part Il Titrating two remaining samples.

1. Add 75 mL of tap water, 8 drops of redox indicator, and 15 mL of the concentrated
sulfuric/phosphoric acid mixture to the lower weight sample.

2. Place several mL of the K;Cr.07 in the clean buret and rinse it with several small portions of the
solution. Fill the buret and zero it using a waste beaker.

3. Titrate this flask to the purple endpoint and record the volume (to the nearest 0.01 mL) of
K2Cr,07 needed in your data table.

4. Repeat these three steps with the remaining sample.

5. Empty all containers of their contents and rinse at least three times with water. Allow buret to
dry upside down and open on its stand. All other glassware should be placed on the drying
racks or on paper towels.

DATA TABLE

Trial 1 Trial 2 Trial 3

Mass of K2Cr207 (g)

Mass of unknown (g)

Volume of K>Cr;07 (mL)
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LABORATORY REPORT (35)

Include your objective and paraphrased procedure in paragraph format. All of your data collected
should be included in your report. Show one calculation of each type. Your calculations should
reveal the following: molarity of K»Cr,07, mass of Fe2* present in each unknown sample, percentage
of Fe2+ in each unknown sample, the calculation of the average percentage of iron in the sample. In
your conclusion, address your findings and any potential errors.
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EXPLORING GAS LAWS

Duration: 2 days

INTRODUCTION

The purpose of this investigation is to conduct a series of experiments, each of which illustrates

a different gas law. Four properties of gases will be investigated: pressure, volume, temperature,
and number of moles. By assembling the equipment, conducting the appropriate tests, and
analyzing your data and observations, you will be able to describe the gas laws, both qualitatively
and mathematically.

OBJECTIVES
In this experiment, you will

» Conduct a set of experiments, each of which illustrates a gas law.
« Gather data to identify the gas law described by each activity.
« Complete the calculations necessary to evaluate the gas law in each activity.

» From your results, derive a single mathematical relationship that relates pressure, volume,

temperature, and number of moles.

MATERIALS

Vernier LabQuest 20-mL gas syringe

Large-volume container for water bath Ice

Vernier Gas Pressure Sensor Plastic tubing with two Luer-lock connectors
125-mL Erlenmeyer flask 100-mL graduated cylinder

Temperature Probe Rubber stopper assembly with two-way valve
Hot plate

PRE-LAB EXERCISE

Review each of the four parts of this experiment before starting your work. You will need to
decide the best way to conduct the testing, so it is wise to make some plans before you begin.
You may wish to conduct a test run without collecting data, in order to observe how the
experiment will proceed.

In each part of the experiment, you will investigate the relationship between two of the four
possible variables, the other two being constant. In this pre-lab exercise, sketch a graph that
describes your hypothesis as to the mathematical relationship between the two variables; e.g.,
direct relationship or inverse relationship.

PartI Pressure, P, and volume, V (temperature and number of moles constant).

Part Il Pressure, P, and absolute temperature, T (volume and number of moles constant).

Part III Volume, V, and absolute temperature, T (pressure and number of moles constant).

Part IV Pressure, P, and number of moles, n (volume and absolute temperature constant).
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PROCEDURE

Part]I Pressure and Volume

1. Position the piston of a plastic 20 mL syringe so that there will be a measured volume of air
trapped in the barrel of the syringe. Attach the syringe to the valve of the Gas Pressure

Sensor as shown below. A gentle half turn should connect the syringe to the sensor securely. Note:
Read the volume at the front edge of the inside black ring on the piston of the syringe, as indicated
by the arrow.

(||{|(mtlltflj!l(ﬂ(|"ie [%@

2. Connect the Gas Pressure Sensor to Channel 1 of the LabQuest. Change your pressure units to
atm.

3. Measure and record the pressure of the air in the syringe at various volumes. The best results
are achieved by collecting at least six data points.

Part Il Pressure and Absolute Temperature

In this experiment, you will study the relationship between the absolute temperature of a gas
sample and the pressure it exerts. Using the apparatus shown below, you will place an
Erlenmeyer flask containing an air sample in a water bath and you will vary the temperature of
the water bath.

1. Connect the Gas Pressure Sensor to Channel 1 and a Temperature Probe to Channel 2 of
the LabQuest.

2. Assemble the apparatus shown above. Be sure that all fittings are airtight. Make sure the
rubber stopper and flask neck are dry, then twist and push hard on the rubber stopper to
ensure a tight fit.

3. Collect and record pressure data (atm) at several different temperatures (K). Set up water baths
in the large- volume container, as you need to do so.
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PartIII Volume and Absolute Temperature

In this experiment, you will study the relationship between the volume of a gas sample and its
absolute temperature. Using the apparatus shown on the next page, you will place an Erlenmeyer
flask containing an air sample in a water bath and you will vary the temperature of the water
bath. Keep some of these factors in mind as you plan your procedure.

« If you are starting with a cold-water bath, set the piston at the 0 mL mark on the syringe.

This will allow the gas volume to be increased in warmer water baths.

» The temperature of the water bath cannot be increased by more than 30-40 degrees from
your starting temperature.

« Even though you are not plotting pressure, it is important to monitor pressure in the Meter to
ensure that it remains constant.

« [t is important to know the total volume of air in the flask and the syringe. The volume of the
flask, up to the bottom of rubber stopper, can be accurately measured using a graduated
cylinder. For the estimated volume of the tubing (from the rubber stopper to the Gas

Pressure Sensor box), as well as in the valve below the bottom of the syringe, use a value

of ~4 mL.

1. Ensure that the Gas Pressure Sensor is plugged into to Channel 1 and the Temperature
Probe is plugged into Channel 2 of the LabQuest.

2. Assemble the apparatus shown above. Be sure that all fittings are air-tight. Make sure that the
rubber stopper and flask neck are dry, then twist and push hard on the rubber stopper to
ensure a tight fit. Be sure that the water level is at least as high as the confined air in the syringe.

3. Collect and record volume data (mL) at several different temperatures (K). Set up water baths in
the large-volume container as you need them, ranging from ice water to hot water. Part IV

PartIV. Pressure and Number of Moles

In this experiment, you will study the relationship between the number of moles in a gas
sample and the pressure exerted.

* You can use the same setup as in the previous trial, although the water bath and
Temperature Probe are optional. (Temperature must be constant, so choose a convenient
temperature to run the experiment.)

* You might be wondering how you are going to count moles for this section. Here is a
hint. Avogadro’s hypothesis states that, “Equal volumes of gases, at the same temperature
and pressure, contain equal numbers of moles.” Therefore, if you keep the temperature
and volume constant during the experiment, you can assume that gas volumes are
proportional to numbers of moles. Instead of entering a total number of moles, you
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could enter a total volume of gas that has been compressed into the flask. For example,
120 mL worth of moles could be entered as 120 moles, 140 mL worth of moles
would be entered as 140 moles.)

1. Ensure that the Gas Pressure Sensor is plugged into Channel 1 of the LabQuest.

2. Collect and pressure data with several different numbers of moles introduced into the
system.

DATA ANALYSIS
1. For each of the four parts of the experiment, construct a graph representing the data that you
collected. Remember to place the independent variable on the x-axis!

2. For each of the four parts of the experiment, write an equation using the two variables and a
proportionality constant, k (e.g., for PartI, P = k x Vif direct, or P = k/V if inverse).

3. Calculate the constant, k, for each of the four gas laws that you tested. This value can be an
average for each of the data pairs in each part of the experiment.

4. Based on the mathematical relationship and equation that you obtained in Step 1 above for
each part of the experiment, combine all four variables into a final equation. This “combined
equation” will contain P, T, V, and n, as well as a new proportionality constant, K. Be sure to
explain how you obtained your result (how you combined the equations).

LABORATORY REPORT (60)

Include your objective and paraphrased procedure in paragraph format. All of your data collected

should be included in your report. Show one calculation of each type. Your calculations should
reveal the following: proportionality constant for each part (k), proportionality constant for
combined equation (K). Your graphs should be included with your lab report. In your conclusion
address your findings and compare them to your predictions made in the pre-lab exercise.
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MOLECULAR WEIGHT OF A VOLATILE LIQUID

Duration: 1 day

INTRODUCTION

The most common instrument of the determination of molecular weights in modern chemical
research is the mass spectrometer. Such an instrument permits very precise determination of
molecular weight and also gives a great deal of structural information about the molecule being
analyzed; this is of great help in the identification of new or unknown compounds.

Mass spectrometers, however, are extremely expensive and take a great deal of time and effort to
calibrate and maintain. In other words, you don’t have one, nor will you get one in the near future!
For these reasons, many of the classical methods of molecular weight determination are still widely
applied. In this experiment, a common modification of the ideal gas law will be used in the
determination of the molecular weight of a liquid that is easily evaporated.

The ideal gas law indicates that the observed properties of a gas sample (P, V, and T) are directly
related to the quantity of the gas in the sample (n). For a given container of fixed volume at a
particular temperature and pressure, only one possible quantity of gas can be present in the
container: n = PV/RT. By careful measurement of the weight of the gas sample under study in the
container, the molecular weight of the gas sample can be calculated. The molecular weight, M,
merely represents the number of grams of the volatile substance per mole: M =g/n

In this experiment, a small amount of volatile liquid will be placed in a flask of known volume. The
flask will be heated in a boiling water bath and its contents will be equilibrated with atmospheric
pressure. From the volume in the flask used, the temperature of the boiling water bath, and the
atmospheric pressure, the number of moles of gas contained in the flask may be calculated. From
the mass of the liquid required to fill the flask with vapor when it is in the boiling water bath, the
molecular weight of the liquid may be calculated.

A major assumption is made in this experiment that may affect your results. You assume that the
vapor of the liquid behaves as an ideal gas. Actually, a vapor behaves least like an ideal gas under
conditions near which the vapor would liquefy. The unknown liquid provided in this experiment
has been chosen because its vapor most readily approaches ideal gas behavior.

OBJECTIVES
In this experiment, you will

» Evaporate a sample of a liquid substance and measure certain physical properties of the

substance as it condenses
» Determine the molar mass of the liquid substance
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MATERIALS

Vernier LabQuest Unknown volatile liquid

Large-volume container for water bath 250-mL Erlenmeyer flask

Temperature Probe Burner

Ring stand Top-loading balance

Utility clamps Triple-beam balance

Al foil

PROCEDURE

1. Prepare a water bath apparatus using a 600-mL beaker filled to half-capacity. Test the volume

of water in the beaker by gently placing a 250-mL Erlenmeyer flask in the beaker and making
certain the flask can be immersed to the 200-mL mark. Add or remove water from the beaker
as needed. Heat the water to boiling. Once it boils, adjust the flame as needed to prevent
splashing.

Clean and completely dry the inside of the flask. The inside of the flask must be completely dry,
since any water present will vaporize under the conditions of the experiment and will adversely
affect the results. Wrap a square of Al foil over the mouth of the flask and weigh the flask and
its cover to the nearest 0.001 g.

Obtain 3-4 mL, exact volume is not needed, of the unknown liquid from the fume hood. Place all
of the unknown liquid in the flask and replace the cover. Make certain that the foil cover is
tightly crimped around the rim of the flask and that it does not extend down the neck of the
flask. At this point, notify me that you are ready for your hole to be punched in the foil cover.

Immerse the flask assembly in the boiling water so that the 200-mL mark on the flask is
immersed. Clamp the neck of the flask to the ring stand using a test tube clamp. Plug the
temperature probe into Channel 1 of the Lab Quest and immerse the probe in the water bath.

Watch the unknown liquid very carefully. The liquid will begin to evaporate rapidly, and its
volume will decrease. The amount of liquid placed in the flask is much more than will be
necessary to fill the flask with vapor at the boiling water temperature. Excess vapor will be
observed escaping through the pinhole in the cover.

When it appears that all of the unknown liquid has vaporized, and the flask is filled with vapor,
continue to heat for 1-2 more minutes. Then very carefully using the clamp on the neck of the
flask to protect your hands, remove the flask from the boiling water.

Place the flask on the lab top, remove the clamp (without disturbing the foil cover), and allow
the flask to cool to room temperature. Liquid will reappear in the flask as the vapor in the flask
cools. While the flask is cooling, measure and record the exact temperature (to the nearest
0.1°C) of the boiling water in the beaker and record the barometric pressure in the laboratory.

When the flask has cooled to room temperature (after about 5 minutes), carefully dry the

outside of the flask to remove any droplets of water. Weigh the flask, foil cover, and condensed
vapor to the nearest 0.001 g.
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10.

11.

Repeat steps 3-8. The weight of the flask after the second sample of unknown liquid is
vaporized and condensed should agree with the first determination within 0.050 g. If it does
not agree, do a third trial.

When two acceptable determinations of vapor weight needed to fill the flask have been
obtained, remove the foil cover from the flask and rinse the flask.

Fill the flask to the very rim with tap water, cover with the foil, and weigh the flask on the triple
beam balance to the nearest 0.1 g. Determine the temperature of the tap water in the flask.
Using the density of water at the temperature of the water in the flask (obtained from the
Handbook of Chemistry and Physics, p. F-5) and the weight of water the flask contains, you will
determine the exact volume of the flask.

DATA ANALYSIS

1.

Using the volume of the flask, the temperature of the boiling water bath, and the barometric
pressure, calculate the number of moles of vapor the flask is capable of containing. Think about
the appropriate units needed for the volume, temperature, and pressure.

Using the mass of the unknown vapor contained in the flask (use an average if your weights
were not identical but were within 0.05 g), and the number of moles of vapor contained in the
flask, calculate the molecular weight of the unknown liquid.

LABORATORY REPORT (40)

Include your objective and paraphrased procedure. All data should be easily read. Show one
calculation of each type. Address both steps of Data Analysis. Remember to write your conclusions.
You will be graded in part on your accuracy of the molecular weight of the liquid. I will give you the
actual molecular weight when I pass your report back to you. At that time, you should add a
calculation of your percentage error in your lab notebook.
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DETERMINING THE CONCENTRATION OF A SOLUTION: BEER’S LAW

Duration: 1 day

INTRODUCTION

The primary objective of this experiment is to determine the concentration of an unknown

copper (1) sulfate solution. You will use a Colorimeter (a side view is shown in Figure 1) to
measure the concentration of each solution. In this experiment, red light from the LED light source
will pass through the solution and strike a photocell. A higher concentration of the colored solution
absorbs more light (and transmits less) than a solution of lower concentration. The Colorimeter
monitors the light received by the photocell as percent transmittance.

_______
_____

-
Y

-

e Light -%

o° o source 4
e e ]
e < | |=dr
'l‘ Detector .:
\“ . :.

-~ . N . b [y 4
b 3, ' s ‘ .
Colorimeter

You will prepare five copper (II) sulfate solutions of known concentration (standard solutions).
Each solution is transferred to a small, rectangular cuvette that is placed into the Colorimeter. The
amount of light that penetrates the solution and strikes the photocell is used to compute the
absorbance of each solution. When you graph absorbance vs. concentration for the standard

solutions, a direct relationship should result. The direct relationship between absorbance and
concentration for a solution is known as Beer’s law.

You will determine the concentration of an unknown CuSO. solution by measuring its absorbance
with the Colorimeter. By locating the absorbance of the unknown on the vertical axis of the graph,
the corresponding concentration can be found on the horizontal axis. The concentration of the
unknown can also be found using the slope of the Beer’s law curve.

OBJECTIVES

In this experiment, you will
* Prepare and test the absorbance of five standard copper (II) sulfate solutions.

Calculate a standard curve from the test results of the standard solutions.

Test the absorbance of a copper (II) sulfate solution of unknown molar concentration.
Calculate the molar concentration of the unknown CuSO4 solution.
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MATERIALS
Vernier LabQuest 0.40 M copper (II) sulfate, CuSO4, solution
Vernier Colorimeter Copper (II) sulfate, CuSO4, unknown solution
Graduated cylinders Stands/buret clamps, burets
Test tubes Distilled water
Cuvette Test tube rack
Beakers Stirring rod
Tissues (lint-free)
PROCEDURE

1. Obtain small volumes of 0.40 M CuSOs4 solution and distilled water in separate beakers.

2. Label five clean, dry, test tubes 1-5. Use burets to prepare five standard solutions according to
the chart below. Thoroughly mix each solution with a stirring rod. Clean and dry the stirring
rod between uses.

Trial 0.40 M CuSOa4 Distilled H20 Concentration
number (mL) (mL) (M)

1 2.0 8.0 0.080

2 4.0 6.0 0.16

3 6.0 4.0 0.24

4 8.0 2.0 0.32

5 10.0 0 0.40

3. Connect the Colorimeter to LabQuest in Channel 1 and choose New from the File menu.

4. Calibrate the Colorimeter. Prepare a blank by filling an empty cuvette 3 /4 full with distilled
water. Place the blank in the cuvette slot of the Colorimeter and close the lid. Press the < or >
buttons on the Colorimeter to set the wavelength to 635 nm (Red). Then calibrate by pressing
the CAL button on the Colorimeter. When the LED stops flashing, the calibration is complete.

5. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. Enter
the Name (Concentration) and Units (mol/L). Select OK.

6. You are now ready to collect absorbance-concentration data for the five standard solutions.
Start data collection. Remove the cuvette from your Colorimeter and pour out the water. Using
the solution in test tube 1, rinse the cuvette twice with ~1 mL amounts, and then fill it 3/4 full.
Wipe the outside with a tissue, place it in the Colorimeter, and close the lid.

*  When the absorbance readings have stabilized, tap Keep and enter 0.080 as the
concentration. Select OK. The absorbance and concentration values have now been saved
for the first solution. Discard the cuvette contents as directed.

¢ Using the solution in test tube 2, rinse the cuvette twice with ~1 mL amounts, and then fill it
3/4 full. Wipe the outside, place it in the Colorimeter, and close the lid. When the
absorbance readings have stabilized, tap Keep and enter 0.16 as the concentration in mol/L.
Select OK.

* Repeat Part these steps for test tube 3 (0.24 M), test tube 4 (0.32M), and the stock 0.40 M
CuSOy4 in test tube 5
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Note: Do not test the unknown solution until Step 8. Stop data collection to view a graph of
absorbance vs. concentration. To examine the data pairs on the displayed graph, select any

data point. As you tap each point, the absorbance and concentration values of each data
point are displayed to the right of the graph. Record the absorbance values in your data
table.

7. Display a graph of absorbance vs. concentration with a linear regression curve. Choose Curve

Fit from the Analyze menu. Select Linear as the Fit Equation. The linear-regression statistics
for these two data columns are displayed for the equation in the form y = mx + b where x is
concentration, y is absorbance, a is the slope, and b is the y-intercept.

* Note: One indicator of the quality of your data is the size of b. It is a very small value if the

regression line passes through or near the origin. The correlation coefficient, r, indicates
how closely the data points match up with (or fit) the regression line. A value of 1.00
indicates a nearly perfect fit.

¢ Select OK. The graph should indicate a direct relationship between absorbance and

concentration, a relationship known as Beer’s law. The regression line should closely fit the
five data points and pass through (or near) the origin of the graph. Record the best-fit line

equation for the standard solutions in your data table.

Determine the absorbance value of the unknown CuSO4 solution. Obtain about 5 mL of the

unknown CuSO4 in another clean, dry, test tube. Record the number of the unknown in your data

table. Rinse the cuvette twice with the unknown solution and fill it about 3/4 full. Wipe the
outside of the cuvette, place it into the Colorimeter, and close the lid. Tap Meter and monitor
the absorbance value displayed on the screen. When this value has stabilized, record it in the

data table. Dispose of any of the remaining solutions as directed.

DATA TABLE
Trial Concentration (mol/L) Absorbance
1 0.080
2 0.16
3 0.24
4 0.32
5 0.40
6 Unknown number ____

Best-fit line equation:
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DATA ANALYSIS
1. Make a graph showing the data and linear-regression equation for the standard solutions.

2. Determine the concentration of the unknown CuSO. solution. Explain how you made this
determination.

3. Describe an alternate method for determining the molar concentration of your unknown sample
of copper (II) sulfate solution, using the standard data.

LABORATORY REPORT (40)

Include your objective and paraphrased procedure. All data should be easily read. Address all
three points of Data Analysis within your report. Show your calculation of the unknown
concentration. Remember to write your conclusions. You will be graded in part on your accuracy
of the concentration of the unknown. [ will give you the actual concentration when I pass your
report back to you. At that time, you should add a calculation of your percentage error in your lab
notebook.
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DETERMINING THE ENTHALPY OF A CHEMICAL REACTION

Duration: 1 day

INTRODUCTION

All chemical reactions involve an exchange of heat energy; therefore, it is tempting to plan to follow
areaction by measuring the enthalpy change (4H). However, it is often not possible to directly
measure the heat energy change of the reactants and products (the system). We can measure the
heat change that occurs in the surroundings by monitoring temperature changes. If we conduct a
reaction between two substances in aqueous solution, then the enthalpy of the reaction can be
indirectly calculated with the following equation.

q=CrxmxAT

The term g represents the heat energy that is gained or lost. C; is the specific heat of water, m is the
mass of water, and AT is the temperature change of the reaction mixture. The specific heat and
mass of water are used because water will either gain or lose heat energy in a reaction that occurs
in aqueous solution. Furthermore, according to a principle known as Hess’s law, the enthalpy
changes of a series of reactions can be combined to calculate the enthalpy change of a reaction that
is the sum of the components of the series.

In this experiment, you will measure the temperature change of two reactions, and use Hess’s law
to determine the enthalpy change, AH of a third reaction. You will use a Styrofoam cup nested in a
beaker as a calorimeter, as shown in the figure below. For purposes of this experiment, you may
assume that the heat loss to the calorimeter and the surrounding air is negligible.

OBJECTIVES
In this experiment, you will

¢ Use Hess’s law to determine the enthalpy change of the reaction between aqueous ammonia
and aqueous hydrochloric acid.
¢ Compare your calculated enthalpy change with the experimental results.
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Calorimeter
MATERIALS
Vernier LabQuest 2.0 M HCI
Temperature Probe 2.0 M NaOH
Glass stirring rod 2.0 M NH4CI
Styrofoam cup 2.0 M NH3
Beaker Ring stand
Graduated cylinders Clamp

PRE-LAB EXERCISE

You will conduct the following three reactions in this experiment. In the space provided below,
write the balanced net ionic reaction equations from the descriptions. Use the table of
thermodynamic data in your text (or another approved resource) to calculate the molar enthalpy of
the reactions.

Reaction 1: An aqueous solution of sodium hydroxide reacts with an aqueous solution of
hydrochloric acid, yielding water.

Reaction 2: An aqueous solution of sodium hydroxide reacts with an aqueous solution of
ammonium chloride, yielding aqueous ammonia, NHs, and water.

Reaction 3: An aqueous solution of hydrochloric acid reacts with aqueous ammonia, NH3, yielding
aqueous ammonium chloride.

Reaction Balanced reaction equation AH (k]/mol)

1

2

3

PROCEDURE
1. Connect the Temperature Probe to LabQuest and choose New from the File menu.

2. Use a utility clamp to suspend the Temperature Probe from a ring stand as shown.

PartI Conduct the Reaction Between Solutions of NaOH and HC1

3. Nesta Styrofoam cup in a beaker, as shown. Measure out 50.0 mL of 2.0 M HClI solution into the
foam cup. Lower the Temperature Probe into the solution. CAUTION: Handle the hydrochloric
acid with care. It can cause painful burns if it comes in contact with the skin.

4. Measure 50.0 mL of NaOH solution, but do not add it to the HCI solution yet. CAUTION: Handle
the sodium hydroxide solution with care.
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Conduct the reaction.

* Start data collection and obtain the initial temperature of the HCI solution.

* After three or four readings have been recorded at the same temperature, add the 50.0 mL of
NaOH solution to the Styrofoam cup all at once. Use a glass stirring rod to stir the reaction
mixture continuously until the temperature reaches a peak and begins to fall.

* Data collection will end after three minutes. If the temperature readings are no longer
changing, you may stop the trial early.

* To examine the data pairs on the displayed graph, select any data point. As you move the
examine line, the temperature values of each data point are displayed to the right of the
graph.

* Record the initial and maximum temperatures in your data table.

Rinse and dry the Temperature Probe, Styrofoam cup, and the stirring rod. Dispose of the
solution as directed.

Part Il Conduct the Reaction Between Solutions of NaOH and NH4Cl

7.

10.

Measure 50.0 mL of 2.0 M NaOH solution into a nested Styrofoam cup. Lower the tip of the
Temperature Probe into the cup of NaOH solution.

Measure 50.0 mL of 2.0 M NH.Cl solution, but do not add it to the NaOH solution yet.

Conduct the reaction.

* Repeat Step 5 with the 50.0 mL of NH4Cl solution
* Examine the graph as before to determine and record the initial and maximum temperatures
of the reaction.

Rinse and dry the Temperature Probe, Styrofoam cup, and the stirring rod. Dispose of the
solution as directed.

Part III Conduct the Reaction Between Solutions of HCl and NH3

11.

12.

13.

Measure 50.0 mL of 2.0 M HClI solution into a nested Styrofoam cup. Lower the tip of the
Temperature Probe into the cup of HCI solution.

Measure 50.0 mL of 2.0 M NH3 solution, but do not add it to the HCI solution yet.

Conduct the reaction.
* Repeat Step 5 with the 50.0 mL of NH3 solution

* Examine the graph as before to determine and record the initial and maximum
temperatures of the reaction.
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DATA TABLE

Reaction 1

Reaction 2

Reaction 3

Maximum temperature (°C)

Initial temperature (°C)

Temperature change (AT)

DATA ANALYSIS

1. Calculate the amount of heat energy, g, produced in each reaction. Use 1.03 g/mL for the density
of all solutions. Use the specific heat of water, 4.18 J/(ge°C), for all solutions.

2. Calculate the enthalpy change, AH, for each reaction in terms of k] /mol of each reactant.

3. Use your answers from #2 above and Hess’s law to determine the experimental molar enthalpy

for Reaction 3.

4. Use Hess’s law, and the accepted values of AH in the Pre-Lab Exercise to calculate the AH for
Reaction 3. How does the accepted value compare to your experimental value?

5. Does this experimental process support Hess’s law? Suggest ways of improving your results.

LABORATORY REPORT (35)

Include your objective and paraphrased procedure. All data should be easily read. Address all five
points of Data Analysis within your report. Show one calculation of each type and the results of

each calculation. Remember to write your conclusions.
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VAPOR PRESSURE AND THE HEAT OF VAPORIZATION

Duration: 2 days

INTRODUCTION

When a liquid is placed in a container, and the container is sealed tightly, a portion of the liquid will
evaporate. The newly formed gas molecules exert pressure in the container, while some of the gas
condenses back into the liquid state. If the temperature inside the container is held constant, then
at some point equilibrium will be reached. At equilibrium, the rate of condensation is equal to the
rate of evaporation. The pressure at equilibrium is called vapor pressure, and will remain constant
as long as the temperature in the container does not change.

In mathematical terms, the relationship between the vapor pressure of a liquid and temperature is
described in the Clausius-Clayperon equation,

InP= &(l) +C
R T
where In P is the natural logarithm of the vapor pressure, AH,q4, is the heat of vaporization, R is the
universal gas constant (8.31 J/moleK), T is the Kelvin temperature, and C is a constant not related to
heat capacity. Thus, the Clausius-Clayperon equation not only describes how vapor pressure is
affected by temperature, but it relates these factors to the heat of vaporization of a liquid. AH,qp is
the amount of energy required to cause the evaporation of one mole of liquid at constant pressure.

In this experiment, you will introduce a specific volume of a volatile liquid into a closed vessel, and
measure the pressure in the vessel at several different temperatures. By analyzing your
measurements, you will be able to calculate the AH,q, of the liquid.

OBJECTIVES
In this experiment, you will

®* Measure the pressure inside a sealed vessel containing a volatile liquid over a range of
temperatures.

* Determine the relationship between pressure and temperature of the volatile liquid.

® C(Calculate the heat of vaporization of the liquid.

MATERIALS

Vernier LabQuest 20-mL syringe

Vernier Gas Pressure Sensor two 125-mL Erlenmeyer flasks
Temperature Probe ethanol, CH3CH,0H

rubber stopper assembly beakers

plastic tubing with two connectors hot plate
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Vapor Pressure Apparatus

PROCEDURE
1. Use a hot plate to heat ~200 mL of water in a 400 mL beaker.

2. Prepare a room temperature water bath in a large beaker. The bath should be deep enough to
completely cover the gas level in the 125 mL Erlenmeyer flask.

3. Connect the Gas Pressure Sensor and Temperature Probe to the LabQuest. Choose New from the
File menu.

4. Use the clear tubing to connect the white rubber stopper to the Gas Pressure Sensor. (About
one-half turn of the fittings will secure the tubing tightly.) Twist the white stopper snugly into the
neck of the Erlenmeyer flask to avoid losing any of the gas that will be produced as the liquid
evaporates. Important: Open the valve on the white stopper.

5. Change the data-collection mode to Selected Events.

6. Your first measurement will be of the pressure of the air in the flask and the room temperature.
Place the Temperature Probe near the flask. When the pressure and temperature readings
stabilize, record these values in the first column (Initial) of your data table.

7. Condition the Erlenmeyer flask and the sensors to the water bath. Place the Temperature Probe
in the room temperature water bath. Place the Erlenmeyer flask in the water bath. Hold the flask
down into the water bath to the bottom of the white stopper. After 30 seconds, close the valve on
the white stopper.

8. Obtain a small amount of ethanol. Draw 3 mL of ethanol into the 20-mL syringe. Thread the
syringe onto the valve on the white stopper.

9. Add ethanol to the flask. Open the valve below the syringe containing the 3 mL of ethanol. Push
down on the plunger of the syringe to inject the ethanol. Quickly pull the plunger back to the 3 mL
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mark. Close the valve below the syringe. Carefully remove the syringe from the stopper so that the
stopper is not moved.

10. Gently rotate the flask in the water bath for a few seconds, using a motion similar to slowly
stirring a cup of coffee or tea, to accelerate the evaporation of the ethanol.

11. Monitor and collect temperature and pressure data. Start data collection. Hold the flask steady
once again. Monitor the pressure and temperature readings. When the readings stabilize, select
Keep.

12. Add a small amount of hot water, from the beaker on the hot plate, to warm the water bath by
3-5°C. Stir the water bath slowly with the Temperature Probe. Monitor the pressure and
temperature readings. When the readings stabilize, select Keep.

13. Repeat Step 12 until you have completed five total trials. Add enough hot water for each trial
so that the temperature of the water bath increases by 3-5°C, but do not warm the water bath
beyond 40°C because the pressure increase may pop the stopper out of the flask. If you must
remove some of the water in the bath, do it carefully so as not to disturb the flask.

14. After you have recorded the fifth set of readings, open the valve to release the pressure in the
flask. Remove the flask from the water bath and take the stopper off of the flask. Dispose of the

ethanol as directed.

15. Stop data collection. Tap Table to see the temperature and pressure measurements. Record the
pressure readings, as P, and the temperature readings in your data table.

DATA TABLE

Initial Trial 1 Trial 2 Trial 3 Trial 4 Trial 5

Ptotal (kPa)

Pair (kPa)

Pap (kPa)

Temperature

Q)
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DATA ANALYSIS
1. The Pai for Trials 2-5 must be calculated because the temperatures were increased. As you
warmed the flask, the air in the flask exerted pressure that you must calculate. Use the gas law
relationship shown below to complete the calculations. Remember that all gas law calculations
require Kelvin temperature. Use the P, from Trial 1 as P; and the Kelvin temperature of Trial 1 as
T:.

A_A

I T,

2. Calculate and record the P4, for each trial by subtracting Pq;- from Pioar.

3. Prepare a graph of P, (y-axis) vs. Celsius temperature (x-axis). Does the plot follow the
expected trend of the effect of temperature on vapor pressure? Explain.

4. Prepare a second graph. The vertical axis for this graph will be the natural logarithm of P, In
Pyap, and the horizontal axis will be the reciprocal of Kelvin temperature (1/7). Calculate the linear
regression (best-fit line) equation for this graph. Calculate AH,q from the slope of the linear
regression using the Clausius-Clayperon equation.

5. The accepted value of the AH,q, of ethanol is 42.32 k] /mol. Compare your experimentally
determined value of AH,q, with the accepted value.

LABORATORY REPORT (45)

Include your objective and paraphrased procedure. All data should be easily read. Address all five
points of Data Analysis within your report. Show one calculation of each type and the results of all
calculations. Remember to write your conclusions.
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USING FREEZING POINT DEPRESSION TO FIND MOLAR MASS

Duration: 2 days

INTRODUCTION
When a solute is dissolved in a solvent, the freezing temperature is lowered in proportion to the
number of moles of solute added. This property, known as freezing-point depression, is a colligative
property; that is, it depends on the ratio of solute and solvent particles, not on the nature of the
substance itself. The equation that shows this relationship is

AT= kfmi
where AT is the freezing point depression (in °C) , kf is the freezing point depression constant for a
particular solvent, (in kg°C/mol), m is the molality of the solution (in mol solute/kg solvent), and i
is the van’t Hoff factor (1 since you will use covalent substances).

OBJECTIVES
In this experiment, you will

* Determine the freezing temperature of the pure solvent, Butylated hydroxytoluene (BHT).
* Determine the freezing temperature of a mixture of BHT and para-dichlorobenzene.

¢ (alculate the freezing point depression of the mixture.

¢ (alculate the freezing point constant for BHT.

* (Calculate the molar mass of an unknown organic solid.

Freezing Point Depression Apparatus

MATERIALS

Vernier LabQuest Butylated Hydroxytoluene, C1sH240
Vernier Temperature Probe Para-dichlorobenzene, CsH4Cl;
Test tubes Unknown organic solid

Beaker Hot plate

Ring stand/clamp
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PROCEDURE
1. Connect the Temperature Probe to LabQuest and choose New from the File menu.

2. On the Meter screen, tap Rate. Change the data-collection rate to 1 sample/second and the
data-collection length to 600 seconds.

Partl Determine the Freezing Temperature of Pure BHT
3. Add about 300 mL of tap water to a beaker. Place the beaker on the base of the ring stand. Heat
the beaker with the water using a hot plate on setting “5” or at “204°C.”

4. Measure about 4 g of BHT and place into a test tube. Record the exact mass of BHT used to the
nearest 0.001 g.

5. Clamp the test tube in the water bath and insert the temperature probe. Heat the water bath to
about 90°C.

6. Start data collection. Remove the test tube from the water bath.

7. With a very slight up-and-down motion of the Temperature Probe, continuously stir the BHT
for the ten-minute duration of the experiment.

8. When data collection is complete, use a hot water bath to melt the BHT enough to safely
remove the Temperature Probe. Carefully wipe any excess BHT liquid from the probe with a
paper towel.

9. The freezing temperature can be determined by finding the mean temperature in the portion of
the graph with nearly constant temperature. Select the data point at the beginning of the flat
portion of the graph and drag across the flat portion to select the region. Choose Statistics from
the Analyze menu. Record the mean (average) temperature as the freezing temperature of
pure BHT.

10. Record or store the data from the first run on a flash drive.
Part Il Determine the Freezing Point of a Solution of BHT and Para-dichlorobenzene
11. Measure about 0.5 g of para-dichlorobenzene onto a piece of weighing paper and record its

exact mass to 0.001g.

12. Place the para-dichlorobenzene into the test tube containing the BHT. Heat the mixture in the
hot water bath until the substances are melted, stirring well to ensure a homogeneous mixture.

13. Repeat steps 1-2 and 6-10.

14. Place the test tube in a 600-mL beaker in the fume hood.

Part III Determine the Freezing Point of a Solution of BHT and Unknown Organic Solid

15. Measure about 4 g of fresh BHT into the test tube and record the exact mass of BHT used to the
nearest 0.001 g.

16. Measure about 0.5 g of your unknown onto a piece of weighing paper and record its exact mass

to the nearest 0.001 g..
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17.

18.

19.

20.

Place the unknown into the test tube containing the BHT. Heat the mixture in the hot water
bath until the substances are melted, stirring well to ensure a homogeneous mixture.

Repeat steps 1-2 and 6-10.
Obtain your test tube from the previous day from the fume hood. Heat both test tubes in your
hot water bath until the mixtures are melted. Pour the melted substances out onto the provided

crumpled newspaper in the fume hood.

Rinse both test tubes with acetone from the fume hood before using soap and water to clean
them.

DATA TABLE

Mass of BHT (g)

Freezing temperature of pure BHT (°C)

Mass of para-dichlorobenzene (g)

Freezing point of BHT/ para-dichlorobenzene (°C)

Freezing point of BHT/ unknown (°C)

DATA ANALYSIS

1.

Graph your data plotting time of cooling versus temperature in °C, you should show the cooling
curves for the pure BHT, the BHT/ para-dichlorobenzene solution, and the BHT /unknown
solution on the same graph. Thus, you should have three distinct curves on your graph. Make
them different colors or different line styles.

Determine the freezing points of the BHT, the BHT/ para-dichlorobenzene solution and the
BHT /unknown solution.

Determine the values of AT¢ for both the BHT and the solution from your data and your graphs.
Calculate the k¢ for BHT from the data of the BHT/ para-dichlorobenzene solution.

Using the calculated k¢ for BHT, calculate the molar mass of the unknown solute.
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LABORATORY REPORT (45)

Include your objective and paraphrased procedure. All data should be easily read. Address all five points of
Data Analysis within your report. Show one calculation of each type and the results of all calculations.
Remember to write your conclusions. You will be graded in part on your accuracy. I will give you the
actual molar mass of the unknown and its identity when I pass your report back to you. At that time, you
should add a calculation of your percentage error in your lab notebook.
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KINETICS OF A REACTION

Duration: 3 days

INTRODUCTION

In this experiment you will study the kinetics of a chemical reaction. The reaction is called a “clock”
reaction because of the means of observing the reaction rate. The reaction involves the oxidation of
iodide ion by bromate ion in the presence of an acid:

6 I-(aq) + BrOs-(aq) + 6 H*(aq) = 3 Iz(aq) + Br-(aq) + 3 H20(1) (Rxn. 1)

The reaction is somewhat slow at room temperature. Its rate depends on the concentration of the
reactants and on the temperature. The rate law is a mathematical expression that relates the
reaction rate to the concentrations of reactants. If you express the rate of reaction as the rate of
decrease in concentration of bromate ion, the rate law has the form:

Rate = -A[BrQ3] = k[I-]x[BrOs]» [H*]=
At

where the brackets refer to the molar concentration of the indicated species. The rate is equal to
the change in concentration of the bromate ion, -A[BrOs] , divided by the change in time for the
reaction to occur, At. The term “k” is the rate constant for the equation, and changes as temperature
changes. The exponents x, y, and z are called the “orders” of the reaction with respect to the
indicated substance and show how the concentration of each substance affects the rate of reaction.
One purpose of the experiment is to determine the total rate law for the process. To do this, you
must measure the rate, evaluate the rate constant, k, and determine the order of the reaction for
each reactant, the values of x, y, and z. A second goal is to determine the activation energy for the
reaction. Lastly you will see the effect a catalyst has on the reaction rate.

To find the rate of the reaction, you need some way of measuring the rate at which one of the
reactants is used, or the rate at which one of the products is formed. The method that you will use
is based on the rate at which iodine forms. If thiosulfate ions are added to the solution, they react
with iodine as it forms in this way:

I>(aq) + 2 S2032-(aq) = 2 I-(aq) + S406%(aq) (Rxn. 2)

Rxn. 1 is somewhat slow. Rxn. 2 proceeds extremely rapidly, so that as quickly as iodine is
produced in Rxn. 1, it is consumed in Rxn. 2. Rxn. 2 continues until all of the thiosulfate is used.
After that, iodine begins to increase in concentration in solution. If some starch is present, iodine
will react with the starch to form a deep blue-colored complex that is readily apparent.

Carrying out Rxn. 1 in the presence of thiosulfate ion and starch produces a chemical “clock.” When
the thiosulfate is consumed, the solution turns blue.

In all of your reactions you will use the same quantity of thiosulfate ion. The blue color appears
when all of the thiosulfate is used. An examination of Rxns. 1 and 2 shows that 6 moles of S;032- are
needed to react with the I, formed from 1 mole of BrOz. Knowing the amount of thiosulfate used
allows the calculation of the amount of I; that is formed, and also the amount of BrOs-that has
reacted at the time of the color change. The reaction rate is expressed as the decrease in
concentration of BrOs-ion divided by the time it takes for the blue color to appear.
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The experiment is designed so that the amounts of the reactants that are consumed are small in
comparison with the total quantities present. This means that the concentration of reactants is
almost unchanged during the reaction, and, therefore, the reaction rate is almost constant during
this time.

The experiment is designed using a microscale procedure. Only 12 drops of reactants delivered
from capillary droppers will be used for each measurement. The steps involved are as follows:
Determine the volume of a drop of solution. This must be done so that the number of moles of
thiosulfate ion can be found, and so the amount of bromate ions that react can be calculated.

Find the order of the reaction for each of the reactants, and determine the rate constant. You will
do this by carrying out an experiment at specific concentrations of each of the reactants and
measuring the reaction rate. Then you will change the concentration of one reactant and observe
how the reaction rate changes. This will be repeated for each reactant. This data allows the
calculation of the order of each reactant. Once the orders are known, the value of the rate constant
can be calculated.

Next you will study the relation between the rate of the reaction and temperature. Reaction rates
always increase as temperature goes up. By measuring how the rate changes as the temperature is
varied, you can determine the activation energy, E, for the reaction. The equation giving this
relation is:
Ink=-E;+InA
RT

where In k is the natural logarithm of the rate constant, E, is the activation energy, R is the gas
constant, 8.314 J/K-mol, and T is the temperature on the Kelvin scale. A is a constant called the
frequency factor which you will not need to determine. This equation follows the straight-line
relationship: y = mx + b. A plot of T 1- versus the natural logarithm of k will give a straight-line
graph. The slope of the graph will be -E./R, and you will use the slope to determine the activation
energy.

In the last part of the experiment you will observe the effect of a catalyst on the rate of the reaction.

OBJECTIVES
In this experiment, you will

¢ Conduct the reaction of iodide, bromate, and hydrogen ions using various concentrations.
* Determine the order of each reactant.

* Determine the rate law for the reaction.

¢ (alculate the activation energy for the reaction.

* Observe the effects of a catalyst on the reaction.
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MATERIALS

Vernier LabQuest 0.010 M KI
Vernier Temperature Probe Distilled H.0
micropipets 0.10 M HCl
96-well plate 2% Starch
Beakers 0.0010M Na;S203
Hot-plate 0.040 M KBrOs3

ice of 0.10M Cu(NOs3):
PROCEDURE

PartI Find the volume of a drop of solution.
1. Find the mass of a small beaker.

2. While holding the dropper vertically, deliver 5 drops of water into the beaker and find the total
mass. Add an additional 5 drops of water and again determine the total mass. Deliver 5 more
drops and again find the total mass.

3. Assume that the density of each of the dilute solutions that will be used is the same as that of
water, 1g/mL.

4. Calculate the volume of one drop of water.

Part Il Determine the reaction rate and calculate the rate law.

The table that follows shows the reagent quantities to be used in carrying out the reactions needed.
Because you do not want the reaction to start until you are ready, be sure that the KBrOssolution is
the last solution added. It is important to use care in measuring the solutions. Since the total
solution volume is quite small, even one extra drop can cause a substantial change in
concentrations.

Exp. KI H,0 HCI Starch NazS203 KBrOs

# 0.010M 0.10M 2% soln 0.0010M 0.040M
1 2 drops 4 drops 2 drops 1 drop 1 drop 2 drops
2 4 drops 2 drops 2 drops 1 drop 1 drop 2 drops
3 6 drops 0 drops 2 drops 1 drop 1 drop 2 drops
4 2 drops 2 drops 2 drops 1 drop 1 drop 4 drops
5 2 drops 0 drops 2 drops 1 drop 1 drop 6 drops
6 2 drops 2 drops 4 drops 1 drop 1 drop 2 drops
7 2 drops 0 drops 6 drops 1 drop 1 drop 2 drops
8 3 drops 1 drop 3 drops 1 drop 1 drop 3 drops

Reagent Quantities

[t is necessary to use consistently good technique to obtain reproducible data. Hold droppers
vertically and be sure no air bubbles are introduced. Since such small quantities of reagents are
used, it is very easy to repeat measurements. Practice your technique by carrying out the first
experiment at least three times (more, if necessary) until your values are reproducible. Calculation
of the orders of reactants are all based on the values obtained for the first experiment, so be sure to get
reproducible data from the beginning. All other experiments should be carried out at least twice.
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A study of the Reagent Quantities table shows that all experiments contain the same total number
of drops of solution. Only one drop of sodium thiosulfate, Na;S,03, and one drop of starch solution
are added to each well. In experiments 1, 2, and 3, the concentration of potassium iodide, K], is
gradually increased while all other volumes remain constant. Experiments 1, 4, and 5 have an
increasing concentration of potassium bromate, KBrOs. Experiments 1, 6, and 7 show an increase in
the concentration of hydrochloric acid, HCl. Experiment 8 will be a test to see if calculated orders of
reactants agree with experimental values.

5. Measure the drops of solutions required for experiment 1 in one of the wells on top of a piece of
white paper. Be sure to add KBrOs last. Stir the mixture thoroughly with a toothpick. This is
very important, because it is impossible to achieve good mixing in the small well without
stirring. Begin timing the reaction as soon as the KBrOs3 is added.

6. Record the time required for the first blue color to appear.

7. Repeat the trials until consistently reproducible values are obtained.

8. Record the room temperature as the temperature of these reactions.

9. Empty the well plate, rinse with water and shake to dry the wells. Use detergent and a cotton
swab, if necessary, to be sure the wells are clean and dry for each experiment.

10. Carry out the experiments with solution volumes described in Experiments 2 through 8.

Part III Determine the activation energy.

In this part of the lab investigation, the reaction will be carried out at several temperatures using
the concentration of Exp. 1. The temperatures will be about 40°C, 20°C, 10°C, and 0°C. Use your
value for Exp. 1 at room temperature for the “about 20°C”"—when graphing, you will use the actual
temperatures—measurement.

11. Prepare a shallow water bath of about 40°C in a beaker.

12. Repeat the procedure using the concentrations in Exp. 1. Mix all of the solutions except the
KBrOs and place the well strip in the warm water bath. Place the pipet containing the KBrOs in the
bath as well.

13. After about 5 minutes in the bath, add the 2 drops of KBrOs3 to the well, stir, and time the
reaction until the blue color first appears. Leave the strip in the bath while you are timing.

14. Repeat the quantities from Exp. 1 for the other two water baths at approximately 10°C, and 0°C.
15. Record the time and temperature for each.

Part IV Observe the effect of a catalyst on the rate.

16. Repeat the procedure for Exp. 1, but this time add 1 drop of 0.10M Cu(NOs); and only 3 drops of
water to the mixture. The total volume will still be 12 drops.

17. Record the reaction time.

Clean all strips and glassware used.
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DATA ANALYSIS

Find the volume of a drop of solution.

1. Find the average mass of 1 drop of water after each addition of 5 drops of water. Remember to
subtract the mass of the beaker!

3. Determine the average of the three average masses of 1 drop of water. This will be your volume
of 1 drop to be used in further calculations.

Determine the reaction rate and calculate the rate law.
Place a table similar to the one below in your lab notebook to facilitate your calculations:

------------------- Time (s)------------------- Initial Concentrations (M)
Exp.# | Trial | Trial | Trial | Trial | Trial | Temp Rxn Rate | [I] [BrOs] | [H*]
1 2 3 4 5 (°Q) (M/s)

RN |UT | DWW (N[

Reaction rate data and preliminary calculations

3. Calculate the rate
Recall that the rate will be expressed as —A[BrOz-]
At
In each reaction, there is 1 drop of 0.0010M Na;S,03 solution. Calculate the number of moles of
Na,S;03 present in 1 drop by:

volume of 1 drop (in L) x 0.0010mol Na,S;03/L = moles S203%ions

The blue color begins to appear when all of the thiosulfate ion is consumed. Examination of Exp. 1
and 2 allows you to calculate the moles of BrOz- which react as all of the S;032- ion is used:

mol S;03%- x _1 moll, x 1mol BrOs = mol BrOsz reacted
2 mol S;032- 3 mol I,

The value of -A[BrOsz-] in all reactions, since all experiments have a total volume of 12 drops is:

-A[BrOsz] = mol BrOz reacted
volume of 12 drops

The rate of each reaction can be found by dividing -A/BrOs] by the average number of seconds
required for the reaction to take place.
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4. Calculate the initial concentrations

Calculate the initial concentration of each reactant for each experiment. This will not be the same
as the concentration of the starting solution because combining the reactants dilutes all of the
solutions. On dilution, the number of moles of reactant stays the same, therefore:

# moles = Vioncentrated X Mconcentrated = Vaitute X Mitute

where Veoncentrated ad Mconcentrated are the volume and molarity of the starting, concentrated
solutions; and Vit and Mgiluee are the volume and molarity of the diluted reaction mixtures. (Wow,
eh?!) Since volumes will be proportional to the number of drops of solution used, you can
substitute drops for volume.

For example, in Exp. 1, the initial [I-] is found in this way:

[I]o=2drops x 0.010M KI = 0.0017M
12 drops solution

Find the initial concentration of each reactant and place it in your table.

5. Calculate the order of each reactant

Next, you need to find the values for the exponents x, y, and z from your rate law expression. This
investigation is designed so that the concentration of one ion changes while the others remain
constant. Comparing values in Exp. 1, 2, and 3, you see that Exp. 2 has 2 times the [I-] as Exp. 1, and
Exp. 3 has 3 times the [I-] as Exp. 1.

Substitute the values for Exp. 1 and 2 into the equation: rate = k[I-]*[BrOs-]y[H*]2. Divide the first
equation by the second equation. Notice that most of the terms will cancel out and you will have:

Rate; = [I]1*
Ratez= [I-]2x

Divide and solve for x. Round the value of x to the nearest integer. Repeat the calculations using
Exp. 1 and 3 to confirm your value for x.

Next, use the same manner with Exp. 1, 4, and 5 to find the value for y. Lastly, use Exp. 1, 6, and 7 to
find the value of z.

6. Calculate the rate constant
Substitute data from each experiment into the rate law equation to find the value of k. Report the
average value of k. Do not forget to include the units of k.

Exp. 8 is a check on your data. Substitute the concentrations of the reactants for Exp. 8 into the rate
law that you determined and calculate the value of the rate of reaction. How does this calculated
rate compare with the measured rate for Exp. 8 from your table?

7. Write the rate law for the reaction.
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Determine the activation energy.

Place a table similar to the one below in your lab notebook to facilitate your calculations:

Temp
Q)

Temp
(K)

Trial
1

Trial
2

Avg,

Rxn. Rate

(M/s)

Rate
constant, k

In k

8. Construct a graph of T 1- (1/K) versus the natural logarithm of k.

9. Calculate the activation energy using the slope of the best-fit line

Activation energy data and preliminary calculations

LABORATORY REPORT (90)

Include your objective and paraphrased procedure. All data should be easily read...you might

reproduce the tables that also include some of your calculated values for ease of reading. Address

all nine steps of the Data Analysis. Show one calculation of each type. Report the results of the

remaining calculations. Remember to write your conclusions. Do state the effect of your catalyst on

the rate. [ will give you the actual rate law when I pass your report back to you. There will be no
percent error calculation for this experiment.
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DETERMINING AN EQUILIBRIUM CONSTANT

Duration: 2 days

INTRODUCTION
Chemical reactions occur to reach a state of equilibrium. The equilibrium state can be characterized
by quantitatively defining its equilibrium constant, Keq. In this experiment, you will determine the
value of K¢, for the reaction between iron (III) ions and thiocyanate ions, SCN-.

Fe3+ (aq) + SCN- (aq) — FeSCN2* (aq)

The equilibrium constant, K., is defined by the equation shown below.

_ [FeSCN**]
“ [Fe’][SCN™]
To find the value of K4, which depends only upon temperature, it is necessary to determine the
molar concentration of each of the three species in solution at equilibrium. You will use a
colorimeter to help you measure the concentrations (see Figure 1). The amount of light absorbed

by a colored solution is proportional to its concentration. The red FeSCN2+ solution absorbs blue
light, and it will be analyzed at 470 nm (blue light).

Light -}
g4 source
ST = | | |[<= -
'l‘ Detector
Colorimeter

In order to successfully evaluate this equilibrium system, it is necessary to conduct three separate
tests. First, you will prepare a series of standard solutions of FeSCN2+ from solutions of varying
concentrations of SCN- and constant concentrations of H* and Fe3+ that are in stoichiometric excess.
The excess of H* ions will ensure that Fe3+ engages in no side reactions (to form FeOH?+, for
example). The excess of Fe3+ ions will make the SCN-ions the limiting reagent, thus all of the SCN-
used will form FeSCN2* ions. The FeSCN2+ complex forms slowly, taking at least one minute for the
color to develop. It is best to take absorbance readings after a specific amount of time has elapsed,
between two and four minutes after preparing the equilibrium mixture. Do not wait much longer
than four minutes to take readings, however, because the mixture is light sensitive and the FeSCN2+
ions will slowly decompose.

In Part II of the experiment, you will analyze a solution of unknown [SCN-] by using the same
procedure that you followed in Part I. In this manner, you will determine the molar concentration of
the SCN- solution.

Third, you will prepare a new series of solutions that have varied concentrations of the Fe3+ions

and the SCN- ions, with a constant concentration of H* ions. You will use the results of this test to
accurately evaluate the equilibrium concentrations of each species.
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OBJECTIVES
In this experiment, you will

* Prepare and test standard solutions of FeSCN2+ in equilibrium.

* Test solutions of SCN- of unknown molar concentration.

* Determine the molar concentrations of the ions present in an equilibrium system.
* Determine the value of the equilibrium constant, K., for the reaction.

MATERIALS

Vernier LabQuest 0.200 M iron (III) nitrate, Fe(NO3)s3, solution
Vernier Colorimeter in 1.0 M HNO3

Temperature Probe (optional) 0.0020 M iron (III) nitrate, Fe(NO3)3, solution
Plastic cuvette in 1.0 M HNO3

Test tubes 0.0020 M thiocyanate, SCN-

Ring stands/clamps/burets Test tube rack

Beakers Potassium thiocyanate, KSCN solution of
Plastic Beral pipets unknown concentration

Distilled water Tissue

PRE-LAB EXERCISE

For the solutions that you will prepare in Step 1 of Part I below, calculate the [FeSCN2+]. Presume
that all of the SCN-ions react. In Part I of the experiment, mol of SCN- = mol of FeSCN2+. Thus, the
calculation of [FeSCN2+] is: mol FeSCN2+ + L of total solution. Record these values in the table below.

Beaker number [FeSCN2+]
0.00 M

G| W[ =

PROCEDURE
Partl Prepare and Test Standard Solutions

1. Connect the Colorimeter to LabQuest and choose New from the File menu.
Calibrate the Colorimeter.
* Prepare a blank by filling an empty cuvette 3/4 full with distilled water.
* Place the blank in the cuvette slot of the Colorimeter and close the lid.
* Press the < or > buttons on the Colorimeter to set the wavelength to 470 nm (Blue). Then
calibrate by pressing the CAL button on the Colorimeter. When the LED stops flashing, the
calibration is complete.

2. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. Enter
the Name (Concentration) and Units (mol/L). Select OK.

3. Label five beakers 1-5. CAUTION: Fe(NO3)3 solutions in this experiment are prepared in
1.0 M HNO3 and should be handled with care. Prepare five solutions according to the chart
below. Do not make more than one solution at a time. Use a buret to distribute the necessary
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amounts of each substance. Mix each solution thoroughly. Measure and record the temperature
of one of the above solutions to use as the temperature for the equilibrium constant, Keq.

Beaker number 0.200 M Fe(NO3)3 0.0020 M SCN- H,0
(mL) (mL) (mL)
1 5.0 0.0 45.0
2 5.0 2.0 43.0
3 5.0 3.0 42.0
4 5.0 4.0 41.0
5 5.0 5.0 40.0

4. You are now ready to collect absorbance data for the standard solutions. Note: Take readings

5.

6.

within 4 minutes of preparing the mixtures.
a. Startdata collection.

b. Empty the water from the cuvette. Using the solution in Beaker 1, rinse the cuvette twice
with ~1 mL amounts and then fill it 3/4 full. Wipe the outside with a tissue, place it in the
colorimeter, and close the lid. When the absorbance readings stabilize, tap Keep and enter
the concentration of FeSCN2+ (from your Pre-Lab exercise) for the first trial. Select OK to
continue.

c. Discard the cuvette contents as directed. Rinse and fill the cuvette with the solution in
Beaker 2. Wipe the outside with a tissue, place it in the colorimeter, and close the lid. Follow
the procedure in Part b of this step to measure the absorbance and enter the concentration
of this solution.

d. Repeat this process to find the absorbance of the solutions in Beakers 3, 4, and 5.

e. Stop data collection to view a graph of absorbance vs. concentration. To examine the data
pairs on the displayed graph, select any data point. As you tap each point, the absorbance
and concentration values of each data point are displayed to the right of the graph.

Record the absorbance values, for each of the five solutions, in your data table.

Display a graph of absorbance vs. concentration with a linear regression curve.
a. Choose Curve Fit from the Analyze menu.

b. Select Linear as the Fit Equation. The linear-regression statistics are displayed to the
right of the graph for the equation in the form y = mx + b.

c. Record the best-fit line equation in your data table and select OK.

Part Il Test an Unknown Solution of SCN-

7.

8.

Obtain 5.0 mL of the unknown into a clean and dry beaker. Add precisely 5.0 mL of 0.200 M
Fe(NO3)3 and 40.0 mL of distilled water to the beaker. Stir the mixture thoroughly.

Using the solution in the beaker, rinse a cuvette twice with ~1 mL amounts and then fill it 34
full. Wipe the outside with a tissue, place it in the colorimeter, and close the lid.
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9. Determine the concentration of the unknown.
a. Tap Meter. Monitor the absorbance readings on the screen.

b. When the readings stabilize, record the absorbance value for your unknown in your data
table.

c. Remove and clean the cuvette.
d. Tap Graph and choose Interpolate from the Analyze menu.

e. Trace the linear regression equation to find the concentration of your unknown at the
absorbance displayed on the meter.

PartIII Prepare and Test Equilibrium Systems

10. Prepare five test tubes of solutions according to the chart below. Follow the necessary steps
from Part I to test the absorbance values of each mixture. Record the results in your data table.
Note: You are using 0.0020 M Fe(NOs3)s in this test.

Test tube 0.0020 M Fe(NO3)s3 0.0020 M SCN- H-0

number (mL) (mL) (mL)
1 3.00 0.00 7.00
2 3.00 2.00 5.00
3 3.00 3.00 4.00
4 3.00 4.00 3.00
5 3.00 5.00 2.00

11. To get good data for the calculation of K, you must determine the net absorbance of the
solutions in test tubes 2-5. To do this, subtract the absorbance reading for test tube 1 from
the absorbance readings of test tubes 2-5, and record these values as net absorbance in your
data table.

DATA TABLE
Parts I and II

Beaker number Absorbance
1

2

3

4

5

Unknown, Part II

Best-fit line equation for the Part I standard solutions:
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Part III

Test tube number Absorbance Net absorbance
1

2

3

DATA ANALYSIS

1. (PartII) Use the best-fit line and the absorbance reading for your unknown solution to
determine the [SCN-].

2. (PartIl) Compare your experimental [SCN-], of your unknown, with the actual [SCN-]. Suggest
reasons for the disparity.

3. (PartIIl) Use the net absorbance values, along with the best fit line equation of the standard
solutions in Part I to determine the [FeSCN2+] at equilibrium for each of the mixtures that you
prepared in Part [II. Complete the table below and give an example of your calculations.

Test tube 2 3 4 5
number

[FeSCN2+]
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4. (PartIll) Calculate the equilibrium concentrations for Fe3+ and SCN- for the mixtures in test
tubes 2-5 in Part III. Complete the table below and give an example of your calculations.

Test tube 2 3 4 5
number

[Fes]

[SCN-]

5. Calculate the value of K, for the reaction. Explain how you used the data to calculate Keq.

LABORATORY REPORT (90)

Include your objective and paraphrased procedure. All data should be easily read...you might
reproduce the tables that also include some of your calculated values for ease of reading. Address
all five steps of the Data Analysis. Show one calculation of each type. Report the results of the
remaining calculations. Remember to write your conclusions. I will give you the actual value of the
K.q when I pass your report back to you. There will be no percent error calculation for this
experiment.
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THE STANDARDIZATION OF SODIUM HYDROXIDE

Duration: 1 day

INTRODUCTION

The technique of titration finds many applications, but is especially useful in the analysis of
acidic and basic substances. Titration involves measuring the exact volume of a solution of known
concentration that is required to react with a measured volume of a solution of unknown
concentration, or with a weighed sample of unknown solid. A solution of accurately known
concentration is called a standard solution. Typically, to be considered a standard solution, the
concentration of the solute in the solution must be known to four significant figures.

In many cases (especially with solid solutes) it is possible to prepare a standard solution by
accurate weighing of the solute, followed by precise dilution to an exactly known volume in a
volumetric flask. Such a standard is said to have been prepared determinately. One of the most
common standard solutions used in analyses, however, cannot be prepared in this manner.

Solutions of sodium hydroxide are commonly used in titration analyses of samples
containing an acidic solute. Although sodium hydroxide is a solid, it is not possible to prepare
standard sodium hydroxide solutions by weight. Solid NaOH is usually of questionable purity.
NaOH reacts with CO; from the atmosphere and is also capable of reacting with the glass of the
container in which it is provided. For these reasons, NaOH solutions are generally prepared to be
approximately a given concentration. They are then standardized by titration of a weighed sample
of a primary standard acidic substance. By measuring how many milliliters of the approximately
prepared NaOH are necessary to react completely with a weighed sample of a known primary
standard acidic substance (in this case, potassium hydrogen phthalate, KHP), the concentration of
the NaOH solution can be calculated. Once prepared, however, the concentration of NaOH solution
will change with time (for the same reasons outlined earlier). As a consequence, NaOH solutions
must be used relatively quickly.

In titration analyses, there must be some means of knowing when enough titrant has been
added to react exactly and completely with the sample being titrated. In an acid/base titration
analysis, there should be an abrupt change in pH when the reaction is complete. For example, if the
sample being titrated is an acid, then the titrant to be used will be basic (probably NaOH). When
one excess drop of titrant is added (beyond that needed to react with the acid sample), the solution
being titrated will suddenly become basic. There are various natural and synthetic dyes, called
indicators that exist in different colored forms at different pH values. A suitable indicator can be
chosen that will change color at a pH value consistent with the point at which the titration reaction
is complete. The indicator to be used in this experiment is phenolphthalein, which is colorless in
acid solutions, but changes to a pink form at basic pH.

OBJECTIVES
In this experiment, you will

» Accurately standardize a solution.

* Become proficient in the use of acid-base titration.

* Determine the equivalence point of a weak acid-strong base titration.
* Calculate the molar concentration of a strong base solution.
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MATERIALS
Sodium hydroxide,NaOH, pellets Erlenmeyer flasks
Balance Phenolphthalein solution
250-mL volumetric flask Wash bottle
Potassium hydrogen phthalate, KHP Distilled water
Beakers
PROCEDURE
1. Clean and rinse a 250-mL volumetric flask with several washings of tap water and then a final

10.

small quantity of distilled water. Label the flask “Approximately 0.2 M NaOH.” Put about 100
mL of distilled water into the flask.

Weigh approximately 2 g of NaOH pellets on weighing paper and transfer to the 250-mL flask.
Stopper and shake the flask to dissolve the NaOH pellets completely. When the NaOH pellets
have completely dissolved, add distilled water to the bottle until the water level is at the etched
line on the neck. Stopper and shake thoroughly to mix.

This NaOH is the titrant for the analyses that follow. Keep the bottle tightly stoppered when not
actually in use (to avoid exposure to the air).

Set up a buret in a buret clamp. Rinse it with tap water, distilled water, and finally, a small
portion of the NaOH that you just prepared. Then fill the buret with the NaOH and zero it,
discarding any waste NaOH in a waste beaker.

Take a clean, dry beaker to the oven that contains the primary standard grade potassium
hydrogen phthalate (KHP) in a 250-mL beaker. Using beaker tongs, remove the KHP from the
oven. Place 3-4 spatulas of KHP into your beaker. Return the 250-mL beaker of KHP to the
oven, and take your beaker to your lab station.

Allow the KHP to cool to room temperature. While it is cooling, clean and dry three 250-mL
Erlenmeyer flasks. Label the flasks as 1, 2, and 3.

When the KHP is completely cool, weigh three samples of KHP on the analytical balance
between 0.6 and 0.8 g, one for each of the Erlenmeyer flasks. Record the exact mass to 0.0001g
of each KHP sample in each flask.

Add 100 mL of distilled water to flask #1. Add 2-3 drops of phenolphthalein and swirl to
dissolve the KHP sample completely.

With a white sheet of paper or paper towel beneath the flask, begin adding NaOH solution from
the buret to the sample in flask #1, swirling the flask constantly during the addition. As the
flashes of pink persist longer and longer, begin adding the NaOH one drop at a time, with
constant swirling. You will stop titrating when one drop makes the pink color persist for at
least 30 seconds with constant agitation. Record the volume of NaOH used to the nearest 0.01
of a mL.

Repeat the titration for the remaining two flasks, recording the volume of NaOH required for
each.
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11. Keep your NaOH solution tightly sealed in preparation for the next experiment. Dispose of the
solutions in the Erlenmeyer flasks as indicated.

DATA ANALYSIS
1. Using the mass of KHP, the molar mass of KHP, the stoichiometric ratio (1:1), the volume of
NaOH used, calculate the molarity of the NaOH solution for each trial. Average the molarity.

LABORATORY REPORT (25)

Include your objective and paraphrased procedure. All data should be easily read. Show one calculation of
each type. Report all calculation results. Remember to write your conclusions. You will use your
standardized solution of NaOH and its average molarity for the next experiment.
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ACID-BASE TITRATION

Duration: 2 days

INTRODUCTION

A titration is a process used to determine the volume of a solution that is needed to react with a
given amount of another substance. In this experiment, your goal is to determine the molar
concentration of two acid solutions by conducting titrations with a base of known concentration.
You will be testing a strong acid, HC], solution and a weak acid, HC;H30, solution. You will use the
sodium hydroxide, NaOH, solution that you standardized in Lab 6 as your base of known
concentration. The reaction equations are shown below in net ionic form.

H+ (aq) + OH- (aq) — H20(1)
HC2H302(aq) + OH- (aq) i HzO(l) + C2H30,- (aq)

The stoichiometry of the two reactions is identical; thus, your calculations will be straightforward.
However, you will observe a significant difference in how the two acid solutions react with NaOH.
In this experiment, you will use a handheld device to monitor pH as you titrate. The region of most
rapid pH change will then be used to determine the equivalence point. The volume of NaOH titrant
used at the equivalence point will be used to determine the molarity of the acid solutions.

OBJECTIVES
* In this experiment, you will

* Accurately conduct acid-base titrations.

* Determine the equivalence point of a strong acid-strong base titration.
* Determine the equivalence point of a weak acid-strong base titration.
* Calculate the molar concentrations of two acid solutions.

Titration Apparatus
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MATERIALS
Vernier LabQuest Stirring bar
Vernier pH Sensor Wash bottle
0.100 M NaOH solution Distilled water
Hydrochloric acid, HC], solution, unknown molarity Ring stand/clamps/burets
Acetic acid, HC;H30, solution, unknown molarity Beaker
Magnetic stirrer Graduated cylinder
PROCEDURE
1. Add 50 mL of distilled water to a beaker. Use a buret to transfer 10.0 mL of the HCl solution

into the beaker. CAUTION: Handle the hydrochloric acid with care. It can cause painful burns if it
comes in contact with the skin.

Place the beaker on a magnetic stirrer and add a stirring bar. If no magnetic stirrer is available,
stir the reaction mixture with a stirring rod during the titration.

Connect the pH Sensor to LabQuest and choose New from the File menu.

Set up a ring stand, buret clamp, and buret to conduct the titration (see Titration Apparatus).
Rinse and fill the buret with 0.100 M NaOH solution. CAUTION: Sodium hydroxide solution is
caustic. Avoid spilling it on your skin or clothing.

Use a clamp to suspend the pH Sensor on the ring stand, as shown in Titration Apparatus.
Position the pH Sensor so that its tip is immersed in the HCl solution but is not struck by the
stirring bar. Gently stir the beaker of acid solution.

On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. Enter
the Name (Volume) and Unit (mL) and select OK.

Conduct the titration carefully, as described below.

¢ Start data collection.

* Before you have added any NaOH solution, tap Keep and enter 0 as the buret volume in mL.
Select OK to store the first data pair.

* Add the next increment of NaOH titrant (enough to raise the pH about 0.15 units). When the
pH stabilizes, tap Keep, and enter the current buret reading as precisely as possible. Select
OK to save the second data pair.

* (Continue adding NaOH solution in increments that raise the pH by about 0.15 units and
enter the buret reading after each increment. When a pH value of approximately 3.5 is
reached, change to a one-drop increment. Enter a new buret reading after each increment.

* After a pH value of approximately 10 is reached, again add larger increments that raise the
pH by about 0.15 pH units, and enter the buret level after each increment.

* Continue adding NaOH solution until the pH value remains constant.

Stop data collection to view a graph of pH vs. volume.

Dispose of the reaction mixture as directed. Rinse the pH Sensor with distilled water in
preparation for the second titration.
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10.

11.

12.

13.

14.

Examine your titration data to identify the region where the pH made the greatest increase. The
equivalence point is in this region.
* To examine the data pairs on the displayed graph, select any data point.

* Asyou move the examine line, the pH and volume values of each data point are displayed to
the right of the graph.

* Identify the equivalence point as precisely as possible and record this information.
* Store the data from the first run by tapping the File Cabinet icon and store on a flash drive.

An alternate way of determining the precise equivalence point of the titration is to take the first
and second derivatives of the pH-volume data.

Determine the peak value on the first derivative vs. volume plot.

* Tap the Table tab and choose New Calculated Column from the Table menu.

* Enter d1 as the Calculated Column Name. Select the equation 1st Derivative (Y,X). Use
Volume as the Column for X and pH as the Column for Y. Select OK.

* On the displayed plot of d1 vs. volume, examine the graph to determine the volume at the
peak value of the first derivative.

Determine the zero value on the second derivative vs. volume plot.

d. Tap Table and choose New Calculated Column from the Table menu.

e. Enter d2 as the Calculated Column Name. Select the equation 2nd Derivative (Y,X). Use
Volume as the Column for X and pH as the Column for Y. Select OK.

f. On the displayed plot of d2 vs. volume, examine the graph to determine the volume when the
2nd derivative equals approximately zero.

Putting aside the ph meter and using bromothymol blue as an indicator, repeat the titration
with a second HCI solution. Bromothymol blue will reach a green endpoint at the equivalence
point.

Using the pH meter, conduct two titration trials with the HC;H30; solution. Note that the
equivalence point of this titration will not be identical to the HCl titration. Analyze the titration
results and record the equivalence point in your data table.

Discard the drained NaOH solution in the 250 mL beaker as directed.

DATA TABLE
Volume Volume Volume Volume
TPdell HCl NaOH Hﬁfrli{;loz HC,H50: NaOH
a (mL) (mL) (mL) (mL)
1 1
2 2
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DATA ANALYSIS
1. Using the molarity of the NaOH, its required volume to reach endpoint, the stoichiometric ratio,
and the volume of acid used, calculate the molarity of the HCI solution and the HC;H30;
solution for each trial.

2. The equivalence points of the titrations curves for the HCI solution and the HC;H30> solution
were not in the same pH range. Explain.

LABORATORY REPORT (35)

Include your objective and paraphrased procedure. All data should be easily read. Show one calculation of
each type. Average your molarities for each of the acids. Report all calculation results. Address both Data
Analysis steps. Remember to write your conclusions. You will be graded in part on your accuracy of the
molarities. I will give you the actual values when I pass your report back to you. At that time, you should
add a calculation of your percentage errors in your lab notebook.
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BUFFERS

Duration: 2 days

INTRODUCTION

A buffer is a mixture of a weak acid and its conjugate base, or a weak base and its conjugate acid. A
buffer’s function is to absorb acids (H* or H30+ ions) or bases (OH- ions) so that the pH of the
system changes very, very little.

In many systems, buffers are critical. Blood plasma, a natural example in humans, is a bicarbonate
buffer that keeps the pH of blood between 7.2 and 7.6.

By design, a buffer is an equilibrium system. For example, a buffer can be prepared with nitrous
acid, HNO.. The weak acid establishes an aqueous equilibrium as shown below.
HNO: (aq) <> H* (aq) + NO2 (aq)
The equilibrium constant expression is shown below.
_[H"][NO;]
¢ [HNO, ]
To prepare a buffer system with nitrous acid, a conjugate base is added, such as sodium nitrite

(NaNO3z). The resulting system is a mixture of HNO; and NO;- ions. The nitrous acid molecule will
neutralize hydroxide ions and the nitrite ion from the conjugate will neutralize hydrogen ions.

A variation of the equilibrium expression above, called the Henderson-Hasselbalch equation, is the
best reference in preparing a buffer solution. For our nitrous acid/sodium nitrate buffer example,
the Henderson-Hasselbalch equation is shown below.
NO;
pH = pK, + logg
[HNO, ]

The pH range in which a buffer solution is effective is generally considered to be =1 of the pKg.

In this experiment, you will use the Henderson-Hasselbalch equation to determine the amount of
acetic acid and sodium acetate needed to prepare two acidic buffer solutions. You will then prepare
the buffers and test their buffer capacities by adding solutions of NaOH and HCI.

OBJECTIVES
In this experiment, you will

* Prepare and test two acid buffer solutions.
* Determine the buffer capacity of the prepared buffers.
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MATERIALS

Vernier LabQuest 0.5 M sodium hydroxide, NaOH, solution
Vernier pH Sensor 0.5 M hydrochloric acid, HCI, solution
Magnetic stirrer and stirring bar 0.1 M acetic acid, HC2H303, solution
Beakers 1.0 M acetic acid, HC;H30, solution
Graduated cylinders Solid sodium acetate, NaC;H30>

Ring stand/clamps/burets Distilled water

Balance

PRE-LAB EXERCISE
Use the Henderson-Hasselbalch equation to perform the following calculations. The K, of acetic acid
is 1.8 x 10-5. Check your calculations with me before preparing the buffer solutions.

» Buffer A: Calculate the mass of solid sodium acetate required to mix with 100.0 mL of 0.1 M
acetic acid to prepare a pH 4 buffer. Record the mass in your data table.

» Buffer B: Calculate the mass of solid sodium acetate required to mix with 100.0 mL of 1.0 M
acetic acid to prepare a pH 4 buffer. Record the mass in your data table.

PROCEDURE
PartI Prepare and Test Buffer Solution A

1. Use your calculations from the Pre-Lab Exercise to prepare 100 mL of Buffer A. Weigh out the
precise mass of sodium acetate and dissolve it in 100.0 mL of 0.1 M acetic acid solution.

2. Setup two burets, buret clamp, and ring stand (see Titration Apparatus). Rinse and fill one
buret with 0.5 M NaOH solution. Rinse and fill the second buret with 0.5 M HCI solution.
CAUTION: Sodium hydroxide solution is caustic. Avoid spilling it on your skin or clothing. Handle
the hydrochloric acid with care. It can cause painful burns if it comes in contact with the skin.

s
\[_739 mL
\—;‘Z Eag 3L
= 40 mL
e S
«—— huret containing hase
Titration Apparatus

4. Use a graduated cylinder to measure out 10.0 mL of the Buffer A solution into a 250 mL beaker
and add 15 mL of distilled water. Place the beaker on a magnetic stirrer, beneath the buret of
NaOH, and add a stirring bar. If no magnetic stirrer is available, you will stir with a stirring rod
during the testing.

5. Connect the pH Sensor to LabQuest and choose New from the File menu. Suspend the pH

Sensor in the pH 4 buffer solution, as shown. Make sure that the sensor is not struck by the
stirring bar.
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10.

On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. Enter
the Name (Volume) and Units (mL). Select OK.

Collect data. You will slowly and carefully add 0.50 M NaOH solution to the sample of Buffer A.

¢ Start data collection.

* Take an initial pH reading of the buffer solution. Allow the pH readings to stabilize and then
tap Keep. Enter 0 as the buret volume in mL. Select OK to save the first data pair. Record
the initial pH value in your data table.

* Add a small amount of the NaOH solution, up to 0.50 mL. When the pH stabilizes, tap Keep.
Enter the current buret reading, and then select OK to save the second data pair.

* (Continue adding the NaOH solution in small increments that raise the pH consistently and
enter the buret reading after each increment. Your goal is to raise the pH of the buffer by
precisely 2 pH units.

* When the pH of the buffer solution is precisely 2 units greater than the initial reading,
continue to add the NaOH solution in small increments until you have reached, and passed,
the equivalence point of the titration.

* Stop data collection to view the graph.
Examine your titration curve.
* To examine the data pairs on the displayed graph, select any data point. As you tap each

point, the pH and volume values of each data point are displayed to the right of the graph.

* Identify the point at which the pH increased by 2 units and record the volume of NaOH in
your data table.

* Store the data from the first trial by tapping the File Cabinet icon and storing on a flash drive.

Dispose of the reaction mixture as directed. Rinse the pH Sensor with distilled water in
preparation for the second trial.

Repeat Steps 7-9, using a fresh 10.0 mL sample of the Buffer A solution. For this second trial,
titrate the buffer with 0.5 M HCI solution. Carefully add HCl in small increments until the pH of
the solution has been lowered by precisely 2 units. Record, in your data table, the volume of
HCI that was used. You may save the data if you wish.

Part Il Prepare and Test Buffer Solution B

11.

12.

Use your calculations from the Pre-Lab Exercise to prepare 100 mL of Buffer B. Weigh out the
precise mass of sodium acetate and dissolve it in 100.0 mL of 1.0 M acetic acid solution. If
necessary, refill the burets of NaOH and HCI solution.

Use a graduated cylinder to measure out 10.0 mL of the Buffer B solution and add 15 mL of
distilled water. Repeat the necessary steps to test Buffer B in a manner similar to the Part I
trials. Determine the volumes of NaOH and HCI that were used to change the pH of Buffer B by
2 units and record the values in your data table.
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DATA TABLE
Buffer A Buffer B
Mass of NaC;H30; used to prepare buffer (g)
Volume of buffer prepared (mL) 100.0 100.0
Molar concentration of HC;H30; in buffer (M) 0.1 1.0

Initial pH of buffer

Volume of 0.5 M NaOH to raise pH by 2 units
(mL)

Volume of 0.5 M HCl to lower pH by 2 units
(mL)

Volume of 0.5 M NaOH at equivalence point
(mL)

DATA ANALYSIS

1. Write reactions to explain how your acetic acid-acetate buffer reacts with a base and how it
reacts with an acid.

2. Graph the average volume of NaOH required for each HC;H30; solution vs the average pH
values.

3. Buffer capacity has a rather loose definition, yet it is an important property of buffers. A
commonly seen definition of buffer capacity is “the amount of hydrogen ion or hydroxide ion
than can be neutralized by a buffer before the pH changes significantly.” Use your data to
determine the buffer capacities of Buffers A and B.

LABORATORY REPORT (35)

Include your objective and paraphrased procedure. All data should be easily read. Show one calculation of
each type from your pre-lab exercises. Report all calculation results. Address all three steps of Data
Analysis in your report. Remember to write your conclusions.
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DETERMINING A SOLUBILITY PRODUCT CONSTANT

Duration: 2 days

INTRODUCTION

The solubility product constant, Ksp, is a particular type of equilibrium constant. The equilibrium is
formed when an ionic solid dissolves in water to form a saturated solution. The equilibrium exists
between the aqueous ions and the undissolved solid. A saturated solution contains the maximum
concentration of ions of the substance that can dissolve at the solution’s temperature. The
equilibrium equation showing the ionic solid lead chloride dissolving in water is:

PbClz(s) <& Pb2+(aq) + 2Cl-(aq)
The solubility product expression is:
Ksp = [Pb2+][Cl]2

where square brackets refer to molar concentrations of the ions. A knowledge of the Ky, of a saltis
useful, since it allows you to determine the concentration of ions of the compound in a saturated
solution. This allows you to control a solution so that precipitation of a compound will not occur, or
to find the concentration needed to cause a precipitate to form.

The solubility product which will be determined by this experiment is that of calcium
hydroxide.

OBJECTIVES
In this experiment, you will

* Perform serial dilutions.
* Determine solubility product constant o calcium hydroxide.

MATERIALS

Beakers 0.1 M sodium hydroxide, NaOH, solution
96-well microplate 0.1 M calcium nitrate, Ca(NOs)2, solution
Beral plastic pipets Distilled water

PROCEDURE

1. Arrange a microplate so that you have 12 wells across from left to right. Put 5 drops of
0.10 M calcium nitrate in well #1 in the first row.

2. Place 5 drops of water in each of the wells #2 through #12 in the first row.
3. Next, add 5 drops of 0.10 M calcium nitrate to well #2. Use an empty Beral pipet to mix the

solution thoroughly by drawing the solution into the pipet and then squirting it back
several times. The solution in this well, #2, is now 0.050 M in Ca2* ion.
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11.

12.

13.

14.

. Use your empty pipet to remove the solution from well #2 and put 5 drops of this solution

into well #3. Put the remaining solution back in well #2. Mix the solution in well #3 as
before.

Continue this serial dilution procedure, adding 5 drops of the previous solution to the 5
drops of water in each well down the row until you fill the last one, #12. Mix the solution in
well #12, and discard 5 drops.

Determine the concentration of solution in each well, and verify that the concentration of
calcium ions in well #12 is 4.9 x 10-5 M.

Place 5 drops of 0.10 M sodium hydroxide, NaOH, in each of the wells #1 through #12.
When the sodium hydroxide is added to each well, the initial concentrations of the reactants
are halved, as each solution dilutes the other. Use 12 empty pipets to mix each of these
combined solutions by drawing each solution up into the pipet and squirting it back into the
well; or mix thoroughly with a toothpick. Now the concentration of Ca2+ions in well #12 is
2.4x10-5M.

Allow three or four minutes for the precipitates to form. Observe the pattern of
precipitation. At one point the concentration of both ions becomes too low to have any
precipitate form. You will assume that the first well with no precipitate represents a
saturated solution.

To check your results, repeat the procedure but use a serial dilution of the NaOH. In a
different row, put 5 drops of 0.10 M sodium hydroxide in well #1.

Put 5 drops of distilled water in wells #2 through # 12. Add 5 drops of the 0.10 M sodium

hydroxide to well #2. Use an empty Beral pipet to mix the solution by pulling the solution

into the pipet and then squirting it back several times. The solution in this well, #2, is now
0.050 M in OH- ion.

Continue the serial dilution to well #12, and then remove 5 drops from well #12.

Add 5 drops of 0.10 M Ca(NOs3): to each of the wells, and mix each with an empty pipet or
toothpick. Again, determine the well where no more precipitate appears.

Calculate the concentration of calcium and hydroxide ions in the first well where there is no
precipitate, and again, calculate the value of K.

DATA ANALYSIS

1.

Using the data from steps 1-8, calculate the concentration of Ca2* ions and OH- ions in the
well where no more precipitate appears. Using these concentrations, determine the
solubility product, the K, of calcium hydroxide.

Using the data from steps 9-13, calculate the concentration of Ca2+* ions and OH- ions in the

well where no more precipitate appears. Using these concentrations, again determine the
solubility product, the K, of calcium hydroxide.
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LABORATORY REPORT (35)

Include your objective and paraphrased procedure. Your observations of each step should be clear. You
need only show one calculation of each type. Show the results of all of your calculations in your report.
Address both steps in Data Analysis. Remember to write your conclusions. You will be graded in part on
your accuracy. | will give you the actual Ky, when I pass your report back to you. At that time, you should
add a calculation of your percentage error in your lab notebook.
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ELECTROCHEMISTRY: VOLTAIC CELLS

Duration: 2 days

INTRODUCTION

In electrochemistry, a voltaic cell is a specially prepared system in which an oxidation-reduction
reaction occurs spontaneously. This spontaneous reaction produces an easily measured electrical
potential. Voltaic cells have a variety of uses.

In this experiment, you will prepare a variety of semi-microscale voltaic cells in a 24-well test plate.
A voltaic cell is constructed by using two metal electrodes and solutions of their respective salts
(the electrolyte component of the cell) with known molar concentrations. In Parts I and II of this
experiment, you will use a Voltage Probe to measure the potential of a voltaic cell with copper and
lead electrodes. You will then test two voltaic cells that have unknown metal electrodes and,
through careful measurements of the cell potentials, identify the unknown metals. In Part III of the
experiment, you will measure the potential of a special type of voltaic cell called a concentration
cell. In the first concentration cell, you will observe how a voltaic cell can maintain a spontaneous
redox reaction with identical copper metal electrodes, but different electrolyte concentrations. You
will then measure the potential of a second concentration cell and use the Nernst equation to
calculate the solubility product constant, Ky, for lead iodide, Pbl..

Voltaic Cells

OBJECTIVES
In this experiment, you will

* Prepare a Cu-Pb voltaic cell and measure its potential.

* Test two voltaic cells that use unknown metal electrodes and identify the metals.
* Prepare a copper concentration cell, observe, and measure its potential.

* Prepare a lead concentration cell and measure its potential.

* Use the Nernst equation to calculate the Ky, of Pbl.
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MATERIALS

Vernier LabQuest
Vernier Voltage Probe
Graduated cylinders
24-well test plate
String

Cu and Pb electrodes

Two unknown electrodes, labeled X and Y

Beakers
Plastic Beral pipets

PRE-LAB EXERCISE

0.10 M copper (II) nitrate, Cu(NOs3)2, solution

0.10 M lead (II) nitrate, Pb(NO3)2, solution
1.0 M copper (II) sulfate, CuSOg, solution
0.050 M potassium iodide, KI, solution

1 M potassium nitrate, KNOs, solution
0.10 M X nitrate solution

0.1 M Y nitrate solution
Steel wool

Use the table of standard reduction potentials in your text, or reputable online source, to complete

the following table. Remember that voltaic cells are to made. An example is provided.

Electrodes

Half-reactions

E°

Eocell

Zn
Cu

Zn(s) — Zn%* + 2e-
Cu?* + 2e- — Cu(s)

+0.76 V
+0.34 V

+1.10V

Cu
Pb

Pb
Ag

Pb
Mg

Pb
Zn

PROCEDURE

PartI Determine the E° for a Cu-Pb Voltaic Cell

1. Use a 24-well test plate as your voltaic cell. Use Beral pipets to transfer small amounts of 0.10
M Cu(NO3)2 and 0.10 M Pb(NO3)2 solution to two neighboring wells in the test plate. CAUTION:
Handle these solutions with care.

2. Obtain one Cu and one Pb metal strip to act as electrodes. Polish each strip with steel wool.
Place the Cu strip in the well of Cu(NO3): solution and place the Pb strip in the well of Pb(NO)3

solution. These are the half cells of your Cu-Pb voltaic cell.

3. Make a salt bridge by soaking a short length of string in a beaker than contains a small amount

of 1 M KNO3 solution. Connect the Cu and Pb half cells with the string.

4. Connect the Voltage Probe to LabQuest and choose New from the File menu.
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Measure the potential of the Cu-Pb voltaic cell. Complete the steps quickly to get the best data.

You will read the potential, in volts, on the LabQuest screen. Write down your readings in
your notebook.

Connect the leads from the Voltage Probe to the Cu and Pb electrodes to get a positive
potential reading. Record the potential immediately after making the connection with the
Voltage Probe.

Remove both electrodes from the solutions. Clean and polish each electrode.

Put the Cu and Pb electrodes back in place to set up the voltaic cell. Connect the Voltage
Probe, as before. Record the potential immediately after making the connection with the
Voltage Probe.

Remove the electrodes. Clean and polish each electrode again.

Set up the voltaic cell a third, and final, time. Record the potential immediately after making
the connection with the Voltage Probe.

Calculate the mean of your three readings and record it in your data table as the average
potential for the Cu-Pb voltaic cell.

‘Part I Determine the E° for Two Voltaic Cells Using Pb and Unknown Metals

6.

10.

Obtain a small amount of the unknown electrolyte solution labeled “0.10 M X” and the
corresponding metal strip, X.

Use a Beral pipet to transfer a small amount of 0.10 M X solution to a well adjacent to the 0.10 M
Pb(NO3): solution in the test plate.

Make a new salt bridge by soaking a short length of string in the beaker of 1 M KNO3 solution.
Connect the X and Pb half cells with the string.

Measure the potential of the X-Pb voltaic cell as you did for the Cu-Pb voltaic cell in step 5,
substituting X for Cu.

Repeat Steps 6-9 using the unknown and its corresponding electrolyte solution labeled “Y”.

Part Il Prepare and Test Two Concentration Cells

11. Setup and test a copper concentration cell.

Prepare 20 mL of 0.050 M CuSO4 solution by mixing 1 mL of 1.0 M CuSO4 solution with 19
mL of distilled water.

Set up a concentration cell in two wells of the 24-well test plate by adding 5 mL of 0.050 M
CuSO04 solution to one well and 5 mL of 1.0 M CuSO4 solution to an adjacent well. Use Cu
metal electrodes in each well. Use a KNOz-soaked string as the salt bridge, as in Parts I and
I

Test and record the potential of the concentration cell in the same manner that you tested
the voltaic cells in Parts I and II.
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12. Determine the solubility product constant, Ky, of Pbls.

* Prepare a small amount of 0.050 M Pb(NOs3); solution by diluting 0.10 M Pb(NO3); solution.
* Mix 9 mL of 0.050 M KI solution with 3 mL of 0.050 M Pb(NO3) solution in a small beaker.

* Set up the half cells in neighboring wells of the 24-well test plate. Place 5 mL of 0.050 M
Pb(NOs3); solution in one half cell, and 5 mL of the Pbl; mixture, from the small beaker, into
an adjacent half cell. Use Pb electrodes in each half cell. Use a KNO3z-soaked string as the salt
bridge.

* Testand record the potential of the cell in the same manner that you tested the voltaic cells
in Part I.

13. Discard the electrodes and the electrolyte solutions as directed. Rinse and clean the 24-well
plate.

DATA TABLE

Results of Parts I and 11 Cu/Pb X/Pb Y/Pb

Average cell potential (V)

Results of Part 111 Cu concentration Pb/Pbl;

Average cell potential (V)

DATA ANALYSIS
1. (Partl) Compare the average cell potential, for your Cu/Pb cell, with the E’ccithat you
calculated in the pre-lab exercise. Explain why your cell potential is different from the cited
value.

2. (PartIl) The unknown metals X and Y were either magnesium, silver, or zinc. Use the cited
value for the reduction potential of Pb and the measured cell potential for the unknowns to
identify X and Y.

3. (PartIIl) Use the Nernst equation to calculate the theoretical value of E of the copper
concentration cell and compare this value with the cell potential that you measured.

4. (PartIll) Use the Nernst equation and the information that you collected about the Pb/Pbl,
cell to complete the following calculations:
a. Use the cell potential for the Pb/Pbl; cell and the known [Pb 2+] to calculate the [Pb2+] in
equilibrium with Pbl..
b. Use the original diluted [Pb 2+] and [I -] to calculate the [I -] in solution.
c. Use your data to calculate the Kj, of Pbl.
d. Compare your experimental value to the accepted value of K, of Pblz as 9.8 x 10-9.
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LABORATORY REPORT (40)
Include your objective and paraphrased procedure. All data should be easily read. Report all calculation
results. Address all four steps of Data Analysis in your report. Remember to write your conclusions.
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